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Data Wersja Zmiany

Zaktualizowanie informacji o mozliwosci wygenerowania
06.2026 v_1 26_003_PL etykiety w formacie ZPL 300 DPI przy pomocy metody
GeneratelabelBusinessPackListTwo

Dodanie metod GenerateBrokerReturn2Home,

05.2026 v.1.26_002_PL GenerateBrokerShippingCodeReturn2Home

03.2026 v_1 26 _001_PL Dodanie metody ORLENPaczkaWeekendOpenPUDOPoints
11.2025 v_1 25 008_PL Mniejsze poprawki tekstu.

10.2025 v_1 25 007_PL Aktualizacja rozdziatu 3.8 oraz 3.14 (ustuga ubezpieczenia).
09.2025 v_1 25 006_PL Aktualizacja opisu metod dla przesytek zwrotu konsumenckiego.

Aktualizacja opisu metod GiveMePackStatus,
03.2025 v_1 25 005 _PL GiveMePackStatusList, GiveMePackStatusFullHistory,
GiveMePackStatusFullHistoryList.

Dodanie statusow wykorzystywanych podczas magazynowania

202 12 L
03.2025 v_1.25_004_P tymczasowego (241, 681, 691, 696, 708).

Dodano opis tagu <BuildingNumber> w metodach zwracajgcych
02.2025 v_1 25 003 _PL dane punktéw odbioru ORLEN Paczka. Tag ten zawiera numer
budynku i numer lokalu (jesli dotyczy) punktu odbioru.

01.2025 v_1_25_002_PL Dodanie specyfikacji linku Track&Trace ORLEN Paczka.
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01.2025

v_1_25 001_PL

Dodanie specyfikacji gabarytéw w ustudze ORLEN Paczka
(S, M, L).

11.2024

v_1 24 002_PL

Dodanie informacji o wytgczeniu ustugi COD (Cash On Delivery).

10.2024

v_1.24 001_PL

Aktualizacja sekcji ‘Wstep’.

Aktualizacja opisow metod oraz ich parametréw.

Dodanie metody GiveMeAllLocationWithAllDataWithZipcode
zwracajacej liste punktéw z rozszerzonym opisem oraz kodem
pocztowym.

Dodanie metody GenerateCustomerReturn.

Dodanie metody GenerateCustomerReturnShippingCode.

Dodanie metody GenerateStandardCustomerReturn.

Dodanie metody GenerateStandardCustomerReturn.

31.08.2023

v_1_23 003_PL

Dodanie metody GiveMeAllLocationWithAllData zwracajgce;j
liste punktow z rozszerzonym opisem.

01.07.2023

v_1_23 002_PL

Dodanie metody GetAvailablePickups zwracajacej liste
zamowionych podjazdow.

12.04.2023

v_1 23 001 _PL

Dodanie metody GiveMeShippingCodeStatusFullHistory i
PutCustomerShippingCodeCanceled.

16.01.2023

v_1 22 003_PL

Dodanie metody CallPickup pickup stuzacej do zamdéwienia
podjazdu kuriera.

14.07.2022

v_1.22 002_PL

Dodanie nowego punktu odbioru o typie <PointType> PPK
akceptujacego gabaryty S, M i L. Punkty PPK nie obstugujg
nadan. Informacja o obstudze wytgcznie odbioréw jest zwracana
w Opisie Lokalizacji <Location>.

25.05.2022

v_1.22 001_PL

Dodanie nowej metody GiveMeAIIRUCHWithFilledD1
umozliwiajgcej pobranie listy punktéw spetniajgcych kryteria
dostawy w czasie D+1.

Dodanie nowej metody Ping sprawdzajacej status potgczenia z
webservice'm API.

Aktualizacja sekcji '"Wstep' o opis procedury generowania etykiet
zwrotnych.

13.10.2021

v_1 16_007_A

Dodanie nowej metody GiveMeAIllAPMLocation umozliwiajgcej
pobranie listy wszystkich Automatéw Paczkowych dostepnych w
ustudze ORLEN Paczka.
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Dodanie do metod GiveMeAIlIRUCHLocation oraz
GiveMeAllIRUCHWithFilled nowych typdw punktow <pointtype>:
APM (Automaty Paczkowe) oraz PKN (Stacje paliw ORLEN).

Dodanie nowych gabarytéw S, M i L do parametru <BoxSize>
wiasciwych dla nowych typdw punktéw APM i PKN.
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3 WSsTEP

3.1 ADRESY WSDL API ORLEN PACZKA

Srodowisko produkcyjne:
https://api.orlenpaczka.pl/WebServicePwRProd/WebServicePwR.asmx?wsdl|

Srodowisko testowe:
https://api-test.orlenpaczka.pl/WebServicePwR/WebServicePwR.asmx?WSDL

AP| ORLEN Paczka jest WebSerwisem opartym na protokole SOAP obstugujgcym wersje SOAP 1.1
oraz SOAP 1.2. Zalecamy korzystanie z wersji SOAP 1.2.

3.2 SYSTEMY AWIZUJACE ORLEN PACZKA

Przesytki nadane w APl ORLEN Paczka nie bedg widoczne w systemie WebTrucker
(https://manager.orlenpaczka.pl/Default.aspx) i odwrotnie.

Przesytki nadane przez APl ORLEN Paczka oraz przez system WebTrucker posiadajg rézne numeracje
oraz nadawane sg za posrednictwem dwdch réznych systemdéw informatycznych.

Przesytki wygenerowane przez API ORLEN Paczka majg numer rozpoczynajgcy od 21. Przesytki
wygenerowane za posrednictwem WebTruckera rozpoczynajg swoj numer od 26.

Historia przesytek nadanych przez APl powinna by¢ przechowywana bezposrednio po stronie
integracji wykorzystujgcej APl ORLEN Paczka. WebTrucker przechowuje jedynie historie przesytek
nadanych przez niego.

3.3 FORMAAUTORYZACJI

Metody wymagajgce autoryzacji wykonujg jg poprzez podanie w wysytanym zgdaniu w polu
<PartnerID> loginu klienta oraz w polu <PartnerKey> hasta klienta.

Dane dostepowe do $srodowiska produkcyjnego oraz testowego (login i hasto) sg udostepniane przez
opiekuna handlowego.

Dane dostepowe do srodowiska testowego rdznig sie od danych dostepowych do sSrodowiska
produkcyjnego.

3.4 POBIERANIE | WIZUALIZACJA DANYCH O LOKALIZACJACH PUDO/APM ORLEN PACZKA

W celu udostepnienia mozliwosci wyboru punktéw odbioru w sieci ORLEN Paczka udostepniamy trzy
mozliwosci:

A. Widget mapy ORLEN Paczka

Link do dokumentac;ji dostepny jest pod adresem:
https://www.orlenpaczka.pl/integracja-z-orlen-paczka - opcja ,, Widget mapy ORLEN Paczka”.

Dla widgetu mapy ORLEN Paczka generowany jest indywidualny token dostepowy.
W celu otrzymania tokenu niezbednego do implementacji widgetu prosimy o kontakt z opiekunem
handlowym podajac ponizsze dane:
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- Adresu sklepu, w ktdrym zostanie osadzona mapa

- numeru klienta (PWR...)

- Jezeli zamierzajg Panstwo testowaé widget w Srodowisku lokalnym (localhost), prosimy o
poinformowanie o tym swojego opiekuna handlowego w zgtoszeniu. Token potrzebny do testéw w
Srodowisku lokalnym jest generowany oddzielnie, ma charakter tymczasowy i wygasa po 3
miesigcach od wygenerowania

B. Starszy widget ORLEN Paczka oparty o mape OpenStreetMap

Link do dokumentacji dostepny jest pod adresem: https://www.orlenpaczka.pl/integracja-z-orlen-
paczka - opcja ,,Widget mapy OSM”.

Dokumentacja zawiera instrukcje instalacje widgetu OSM wraz z przyktadami mozliwych
implementacji w PHP.

Paczka z przyktadowymi implementacjami nie zawiera wtyczki, tylko w instrukcji odwotuje sie do
wszystkich linkéw pluginu produkcyjnego.

C. Pobieranie danych o punktach PUDO za posrednictwem APl ORLEN Paczka

Zalecamy korzystaé z metody GiveMeAllLocationWithAllDataWithZipcode w celu pobrania listy
wszystkich typow z rozszerzonym opisem punktéw oraz kodami pocztowymi.

Aktualizacja baz danych punktéw PUDO nastepuje raz dziennie w godzinach porannych. W celu
zachowania aktualnych danych zalecamy pobranie listy punktéw raz dziennie po godzinie 6.

Pozostate metody stuzace do pobierania listy punktéw umieszczone sg w niniejszej dokumentacji w
rozdziatach 4.14 — 4.22.

Typy punktédw dostepnych w ustudze ORLEN Paczka zwracanych w parametrze <PointType>:
APM - Automaty Paczkowe

PKN - Stacje ORLEN

PSD - Punkt Sprzedazy Detalicznej (Kioski RUCH) — punkty obstugujgce ustuge COD (od dnia
01.01.2025 punkty PSD zostaty zamkniete)

PPP - Punkt Pozaprasowy

PPK - Punkty sieci PointPack — punkty obstugujace jedynie odbiory przesytek

Zmiana w sposobie zwracania danych adresowych dla metod pobierajacych dane o punktach
PUDO/APM.

Od 1 stycznia 2025 roku nazwa ulicy, przy ktorej znajduje sie punkt PUDO/APM, bedzie zwracana w
tagu <StreetName>, natomiast numer ulicy i numer lokalu beda zwracane w tagu <BuildingNumber>.
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3.5 PRZEKAZYWANIE DANYCH AWIZACYJNYCH | GENEROWANIE ETYKIET

3.5.1 Dodatkowe dane do celéw raportowych

Parametr ,TransferDescription” stuzy do wprowadzania dowolnych danych, takich jak dane
referencyjne nadawcy (na przyktad: numer zamodwienia, identyfikator kupujgcego, zawartosc paczki).
Dane przekazane w polu ,TransferDescription” nie sg drukowane na etykiecie.

Parametr ,SenderOrders” stuzy do wprowadzania dowolnych danych, takich jak dane referencyjne
nadawcy (na przyktad: numer zamdwienia, identyfikator kupujacego, zawartos¢ paczki). Dane
przekazane w polu ,SenderOrders” sg drukowane na etykiecie.

Parametry , ExternalSenderPackageNumber”, ,ExternalPackageNumber” dostepne w metodach
GenerateStandardCustomerReturn, GenerateStandardCustomerReturnShippingCode stuzg do
wprowadzania dowolnych danych, takich jak dane referencyjne nadawcy (na przykfad: numer
zamowienia, identyfikator kupujgcego, zawartosc paczki). Dane przekazane w polach
,ExternalSenderPackageNumber”, , ExternalPackageNumber” nie sg drukowane na etykiecie.

Na zyczenie klienta, po konsultacji z opiekunem handlowym ORLEN Paczka, wygenerowany zostanie
raport nadan zawierajgcy wprowadzone w tych parametrach dane.

3.5.2 Deklaracja identyfikatoréow punktéw odbioru ORLEN Paczka
W metodach awizujgcych przekazac nalezy w polu <DestinationCode> wartos$¢ zwrécong w polu
<DestinationCode> metody GiveMeAllLocationWithAllIDataWithZipcode.

W momencie przekazywania danych awizacyjnych (rozdziat 3.5.3) nalezy deklarowacé petny lub
uniwersalny identyfikator punktu odbioru.

Identyfikator punktu odbioru zwracany jest w parametrze DestinationCode przez metody opisane w
rozdziale 3.3 — punkt C.

Przyktad: <DestinationCode>WS-116263-C3-01</DestinationCode>

Identyfikator uniwersalny tworzony jest poprzez zamiane prefixu na wartos¢ XX oraz zamiane sufixu
na 00-00.

Przyktad: XX-116263-00-00.

Przekazanie identyfikatora uniwersalnego spowoduje prawidtowe wygenerowanie numeru przesytki
oraz etykiety nadawczej pomimo zwrécenia komunikatu ostrzegawczego ,,Zapisano ale zmieniono
DestinationCode” (rozdziat 6).

3.5.3 ORLEN Paczka udostepnia trzy scenariusze przekazywania danych awizacyjnych oraz
generowania etykiet:

A: Zalecamy korzystanie z metody GeneratelLabelBusinessPackListTwo stuzgcej do rezerwowania
numeru listu przewozowego oraz generowania etykiety. Metoda ta umozliwia awizowanie
pojedynczej paczki lub listy przesytek ORLEN Paczka, w odpowiedzi zwraca etykiete zbiorczg w
formacie PDF, PDF10, EPL, ZPL lub ZPL 300 DPI.

Pozostate metody stuzgce do przekazywania danych awizacyjnych oraz generowania etykiet
umieszczone sg W niniejszej dokumentacji w rozdziatach 4.4 — 4.7.
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B: Rezerwacja numeru listu przewozowego z wykorzystaniem jednej metody, a nastepnie
wygenerowanie etykiety nadawczej dodatkowa metoda.

Krok 1.

Wywotanie metody GenerateBusinessPack stuzgcej do przekazania danych awizacyjnych do
systemow ORLEN Paczka. Metoda ta nie zwraca etykiety nadawczej w odpowiedzi. W odpowiedzi
system zwraca numer listu przewozowego, dla ktérego nalezy wygenerowac etykiete.

Krok 2.
W celu wygenerowania etykiety dla przesytki, ktdra zostata zaawizowana w kroku pierwszym
zalecane jest skorzystanie z metody LabelPrintDuplicatelListTwo (rozdziat 4.33).

Pozostate metody stuzgce do pobierania duplikatow etykiety nadawczej umieszczone sg w niniejszej
dokumentacji w rozdziatach 4.30 — 4.33.

C: Przekazanie danych awizacyjnych oraz generowanie etykiety dla zarezerwowanej puli numeréw
przesytek.

Zastosowanie tego scenariusza jest mozliwe wytgcznie po uzyskaniu zgody opiekuna handlowego
ORLEN Paczka.

Scenariusz sktada sie z trzech kolejnych krokdéw:

Krok 1. Rezerwacja puli numerdéw przesytek.

W celu rezerwacji puli numerdw nalezy skorzysta¢ z metody GenerateNumberWaybills (rozdziat 4.8).
Tak zarezerwowane numery przesytek nie majg terminu waznosci. Na tym etapie paczka nie jest
zaawizowana w systemach ORLEN Paczka co oznacza, ze nie otrzymuje statusu trackingowego i nie
jest widoczna na stronie $ledzenia paczek (www.orlenpaczka.pl/sledz-paczke).

Krok 2. Przekazanie danych awizacyjnych.

Nastepnie w celu przekazania danych awizacyjnych do numeru przesytki zarezerwowanym w kroku
pierwszym nalezy skorzysta¢ z metody PutCustomerPack (rozdziat 4.34).

Uwaga: Jesli przesytka nie zostanie przekazana do sieci ORLEN Paczka w ciggu 14 dni kalendarzowych
od momentu awizacji, zostanie automatycznie anulowana.

Krok 3. Pobranie etykiety nadawcze;j.

Proces pobrania etykiety nadawczej dla zaawizowanej paczki w kroku drugim za posrednictwem
zalecanej metody LabelPrintDuplicateListTwo (rozdziat 4.33) lub metod opisanych w rozdziatach 4.30
—4.33,

Tag <PackPrice> zawarty w odpowiedzi metod awizujgcych jest bezposrednio powigzany z
zadeklarowanym gabarytem przesyiki. Jego wartos¢, nie stanowi ostatecznej kwoty za ustuge
kurierskg. Ostateczna cena jest ustalana indywidualnie z opiekunem handlowym podczas
podpisywania umowy. Ponizej przedstawiono standardowe wartosci tagu <PackPrice> dla réznych
gabarytéw, obowigzujace dla wszystkich klientéw ORLEN Paczka:

REQUEST: <BoxSize>S</BoxSize>

RESPONSE: <PackPrice>999</PackPrice>

REQUEST: <BoxSize>M</BoxSize>
RESPONSE: <PackPrice>1099</PackPrice>
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REQUEST: <BoxSize>L</BoxSize>
RESPONSE: <PackPrice>1299</PackPrice>

Tag <PackPaid> zawarty w odpowiedzi metod awizujgcych okresla typ konta klienta:
<PackPaid>true</PackPaid> - oznacza, ze umowa biznesowa zostata podpisana i ma status POSTPAID
w systemach ORLEN Paczka.

<PackPaid>false</PackPaid> - oznacza, ze umowa biznesowa nie zostata podpisana i ma status
PREPAID w systemach ORLEN Paczka.

3.6 TERMIN WAZNOSCI ETYKIET

Etykiety wygenerowane za posrednictwem API ORLEN Paczka wazne sg przez 14 dni od daty
wygenerowania etykiety nadawczej.

W sytuacji, gdy przesytka nie zostanie przyjeta do sieci ORLEN Paczka w okresie 14 dni od daty
zaawizowania zostaje ona automatycznie anulowana oraz otrzymuje status ,,201 - anulowane awizo”.

3.7 GENEROWANIE PROTOKOLOW PRZEKAZANIA PRZESYLEK KURIEROWI

W celu wygenerowania protokotu przekazania nalezy skorzysta¢ z metody GenerateProtocol (rozdziat
4.9).

Plik protokotu zwracany jest w formacie PDF dla wskazanych numeréw paczek zaawizowanych do
ORLEN Paczka. Dodatkowo metoda zwraca btedne paczki (wszystkie majace inny status niz
zaawizowane) oraz poprawne paczki wraz numerem protokotu.

3.8 ZAMOWIENIE KURIERA ORAZ SPRAWDZENIE MOZLIWOSCI PODJAZDU POD WSKAZANY
ADRES

W celu wezwania kuriera po odbiér paczek nalezy postgpi¢ zgodnie z ponizszymi krokami.

Krok 1. Sprawdzenie dostepnosci przedziatow godzinowych kuriera dla kodu pocztowego nadawcy
przesytki.

Aby, dokonaé weryfikacji dostepnych przedziatéw godzinowych kuriera nalezy skorzysta¢ z metody
GetAvailablePickups (rozdziat 4.39).

Metoda zwraca liste najblizszych dostepnych dat i godzin podjazdéw dla wskazanej kodu
pocztowego.

W odpowiedzi metody zwracany jest parametr ,Minimuminterval”, ktéry okresla minimalny czas
wezwania kuriera wedle korica przedziatu godzinowego. Wartosé ,,Minimumlnterval” zwracana jest
jako ilos¢ minut.

Przyktad:

ponizszy przedziat godzinowy wskazuje na dostepnos¢ kuriera od godziny 08:00 do godziny 16:00

<AvailablePickupDay>
<Date>2024-08-29</Date>
<MinReadyDate>2024-08-29T08:00:00+02:00</MinReadyDate>
<MaxPickupDate>2024-08-29T16:00:00+02:00</MaxPickupDate>
<MinimumInterval>120</Minimumlnterval>
</AvailablePickupDay>
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Warto$é zwrdconego parametru <Minimuminterval>120</Minimuminterval> oznacza, ze
zamowienie kuriera mozna ztozy¢ najpdzniej do godziny 14:00 (wedle wzoru 16:00 — 2 godziny =
14:00).

Krok 2. Wezwanie przyjazdu kuriera po odbidr przesytek.

Zeby zamoéwié podjazd kuriera zalecamy skorzystaé z metody CallPickupNew (rozdziat 4.38). Metoda
pozwala na wprowadzenie konkretnego adresu razem z godzinami mozliwego podjazdu pobranego z
odpowiedzi metody GetAvailablePickups.

Wezwanie kuriera mozliwe jest takze z pomocg metody CallPickup (rozdziat 4.37), ktéra
automatycznie pobiera adres przyjazdu z danych przypisanych do umowy klienta w systemie ORLEN
Paczka zdefiniowanych podczas podpisywania umowy.

Gdy w kroku pierwszym metoda GetAvailablePickups zwrdcita dostepny przedziat godzinowy 8:00 —
16:00 w wywotaniu metody CallPickupNew mozna zadeklarowac ponizsze przyktadowe przedziaty:

Przedziat godzinowy 8:00 — 10:00. Zlecenie nalezy ztozy¢ najpdzniej do godziny 8:00.
<ReadyDate>2024-08-29T08:00:00+02:00</ReadyDate>
<PickupDate>2024-08-29T10:00:00+02:00</PickupDate>

Przedziat godzinowy 12:00 — 15:00. Zlecenie nalezy ztozy¢ najpdzniej do godziny 12:00.
<ReadyDate>2024-08-29T12:00:00+02:00</ReadyDate>
<PickupDate>2024-08-29T15:00:00+02:00</PickupDate>

Przedziat godzinowy 14:00 — 16:00. Zlecenie nalezy ztozy¢ najpdzniej do godziny 14:00.
<ReadyDate>2024-08-29T14:00:00+02:00</ReadyDate>
<PickupDate>2024-08-29T16:00:00+02:00</PickupDate>

UWAGA!
Przyktadowe przedziaty godzinowe przekazywane w wywotaniu do API nie sg ostatecznymi, a jedynie
sugerowanymi godzinami odbioru.

Przyktady deklaracji nieprawidtowych przedziatéw, niespetniajgcych wymogu minimalnego odstepu
czasowego <Minimuminterval>120</MinimumInterval>:

<ReadyDate>2024-08-29T08:00:00+02:00</ReadyDate>
<PickupDate>2024-08-29T09:00:00+02:00</PickupDate>

<ReadyDate>2024-08-29T15:00:00+02:00</ReadyDate>
<PickupDate>2024-08-29T16:00:00+02:00</PickupDate>

3.9 POBIERANIE STATUSOW TRACKINGOWYCH

Statusy trackingowe przesytek mozna pobrac za posrednictwem metod opisanych w rozdziatach 4.23
—4.26.
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3.9.1 SLEDZENIE PRZESYLEK W SERWISIE TRACK&TRACE ORLEN PACZKA

Aby sledzié¢ status przesytki, nalezy skorzystac z ponizszego linku, podmieniajgc @numerpaczki na
rzeczywisty numer przesytki otrzymany w odpowiedzi na zgdanie awizowania:
https://www.orlenpaczka.pl/sledz-paczke/?numer=@numerpaczki

Sledzone moga by¢ tylko przesytki wygenerowane na $rodowiskach produkcyjnych ORLEN Paczka,
zaréwno przez APl oraz WebTrucker (https://manager.orlenpaczka.pl/Default.aspx).
Przesytki wygenerowana na srodowisku testowym nie bedg widoczne na T&T produkcyjnym.

3.10 ZWROTY KONSUMENCKIE

Aby skorzystac z ustugi zwrotu konsumenckiego, nalezy wybrac jeden z ponizszych scenariuszy:
A. ZWROT KONSUMECKI POWIAZANY Z PACZKA PIERWOTNA - NADANIE NA ETYKIECIE

Metoda ,, GenerateCustomerReturn” stuzy do generowania zwrotow w serwisie zwrotu
konsumenckiego. Zwrot jest powigzany z przesytkg pierwotng. Metoda opisana jest w rozdziale 4.42.

B. ZWROT KONSUMECKI POWIAZANY Z PACZKA PIERWOTNA - NADANIE BEZ ETYKIETY

Metoda , GenerateCustomerReturnShippingCode” stuzy do generowania zwrotéw w serwisie zwrotu
konsumenckiego bez etykiety. Zwrot jest powigzany z przesytka pierwotng. Metoda opisana jest w
rozdziale 4.43.

C. ZWROT KONSUMECKI NIE POWIAZANY Z PACZKA PIERWOTNA - NADANIE NA ETYKIECIE

Metoda , GenerateStandardCustomerReturn” stuzy do generowania zwrotéw w serwisie zwrotu
konsumenckiego. Zwrot nie jest powigzany z przesytka pierwotng. Metoda opisana jest w rozdziale
4.44.

Zgodnie z ustaleniami biznesowymi z opiekunem handlowym przesytka wygenerowana tg metoda
kierowana jest na adres siedziby firmy lub na adres wskazany do zwrotow.

D. ZWROT KONSUMECKI NIE POWIAZANY Z PACZKA PIERWOTNA - NADANIE BEZ ETYKIETY

Metoda , GenerateStandardCustomerReturnShippingCode” stuzy do generowania zwrotéw w
serwisie zwrotu konsumenckiego bez etykiety. Zwrot nie jest powigzany z przesytkg pierwotna.
Metoda opisana jest w rozdziale 4.45.

Zgodnie z ustaleniami biznesowymi z opiekunem handlowym przesytka wygenerowana tg metodg
kierowana jest na adres siedziby firmy lub na adres wskazany do zwrotow.

3.11 NUMER PACZKI PIERWOTNEJ

Aby uzyskaé pierwotny numeru paczki w przypadku posiadania numeru paczki zwrotnej nalezy
skorzysta¢ z metody GiveMasterPack (rozdziat 4.13).
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3.12 PACZKA POBRANIOWA

Zgodnie z decyzjg biznesowg, z dniem 2 stycznia 2025 roku ustuga ptatnosci przy odbiorze (COD)
zostata wytaczona.

Prosimy o usuniecie parametréw <CashOnDelivery> oraz <AmountCashOnDelivery> w swoich
wywotaniach do APl ORLEN Paczka.

3.13 GABARYTY PRZESYLEK

W momencie awizacji danych do systemdéw ORLEN Paczka nalezy pamietaé o wypetnieniu pola
<BoxSize> wartoscig S, M lub L. Pole to jest odpowiedzialne za zdefiniowanie jednego z trzech
dostepnych gabarytéw przesytki. W przeciwnym razie dla paczki zostanie przypisany gabaryt M.

Specyfikacja gabarytéw w ustudze ORLEN Paczka:
S: 8 x 38 x 60 cm, max 20 kg

M: 19 x 38 x 60 cm, max 20 kg

L: 41 x 38 x 60 cm, max 20 kg

3.14 USLUGA UBEZPIECZENIA PRZESYLKI

Zgodnie z decyzjg biznesowg, z dniem 4 grudnia 2024 roku ustuga ubezpieczenia przesytki zostata
wytaczona.

W zwigzku z tym kazda préba wygenerowania etykiety z aktywng opcjg ubezpieczenia zakonczy sie
btedem: ,,no permission to Insurance”

Aby zapewni¢ poprawne generowanie etykiet i zachowaé zgodnos$¢ z aktualng specyfikacja APl ORLEN
Paczki:

e Nalezy usungc¢ parametry <Insurance> oraz <PackValue> z wywotan Panistwa systemu do API
ORLEN Paczki.

e Alternatywnie, prosimy o ustawienie wartosci deklaracji ubezpieczenia <Insurance> na F
(fatsz) w Panstwa zgdaniach.

Zgodnie z obowigzujgcym Regulaminem ORLEN Paczki, ustuga ubezpieczenia zostata zastgpiona
domysing odpowiedzialnoscig za przesyiki.

Odpowiedzialnos¢ za przesytki obejmuje wartosé¢ do 5000 zt i jest automatycznie uwzgledniana — nie
ma potrzeby dodawania dodatkowego ubezpieczenia podczas generowania zamdwienia.

Regulamin dostepny jest pod adresem:
https://www.orlenpaczka.pl/wp-content/uploads/2025/07/Regulamin-swiadczenia-przedsiebiorcom-
uslug-pocztowych-i-przewozowych-od-25-sierpnia-2025-r..pdf
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4 MEeToDY

Przyktady wywotan dla wszystkich ponizszych metod dostepne sg w zestawieniu pod adresem:
Srodowisko produkcyjne: https://api.orlenpaczka.pl/WebServicePwRProd/WebServicePwR.asmx

$rodowisko testowe: https://api-test.orlenpaczka.pl/WebServicePwR/WebServicePwR.asmx

Metody o nazwach GeneratelLabelBusinessPackAllegro, GeneratelLabelBusinessPackListAllegro,
GenerateOrlenPaczkalLabel, GenerateOrlenPaczkaShippingCode,
GenerateOrlenPaczkaShippingCodeReturn2Home s3 narzedziami przeznaczonymi wytgcznie do
wewnetrznego uzytku firmy Allegro.

Prosimy o niekorzystanie z nich w ramach budowanych przez Panstwa rozwigzan.

Program Allegro SMART

Klient nadajacy przesytki z umowy wtasnej korzystajgc z APl ORLEN Paczka przez dowolng wtyczke
integrujgcya z ustugami ORLEN Paczka, zostanie rozliczony zgodnie z cennikiem ORLEN Paczka.
Umowa wtasna klienta sporzgdzona z opiekunem handlowym ORLEN Paczka funkcjonuje na innych
zasadach fakturowania niz umowa brokerska Allegro.

Aby, przesytki mogty zostac zakwalifikowane do programu Allegro SMART i rozliczone zgodnie z
cennikiem tego programu, etykiety przewozowe muszg zosta¢ wygenerowane w portalu "Wysytam z
Allegro" lub w integracji z Allegro korzystajgcej z umowy brokerskiej Allegro.

41 CREATECUSTOMER

Dostep do metody mozliwy jest wytgcznie po uzyskaniu zgody opiekuna handlowego ORLEN Paczka.
Metoda stuzy do tworzenia nowego klienta ORLEN Paczka.

411 Wywolanie

Parametry wywotania:

Identyfikator Klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char

Hasto Klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<FirstName> Imie odbiorcy 30 char
<LastName> Nazwisko odbiorcy 30 char
<CompanyName> Firma odbiorcy 70 char
<Nip> NIP tworzonego klienta (REQUIRED) 10 char
<City> Miasto z adresu odbiorcy 30 char
<StreetName> Ulica z adresu odbiorcy 30 char

Numer budynku z adresu
<BuildingNumber> odbiorcy 10 char
<PostCode> Kod pocztowy z adresu odbiorcy 6 char
<EMail> Adres email odbiorcy 60 char

(REQUIRED)

<PhoneNumber> Numer telefonu odbiorcy 9 char — numer bez prefixu +48
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| 12 char — numer z prefixem +48

Podczas tworzenia nowego klienta nalezy wprowadzi¢ nr NIP sktadajgcy sie wytgcznie z 10 cyfr (bez

spacji lub znakéw specjalnych).

Przyktad z minimalng wymagana listg pdl:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<Nip>123-456-78-90</Nip>
<City>Warszawa</City>
<CompanyName>Firma SA</CompanyName>
<StreetName></StreetName>
<BuildingNumber></BuildingNumber>
<FlatNumber></FlatNumber>
<PostCode></PostCode>
<PhoneNumber></PhoneNumber>
<EMail></EMail>

412  Odpowiedz
Zwracane wartosci:
<Err> Numer btedu
<ErrDes> Opis btedu

<NewCustomerPartnerID>

Identyfikator utworzonego Klienta

<NewCustomerPartnerKey>

Hasto utworzonego Klienta

Przyktad:

<Err>000</Err>
<ErrDes>saved</ErrDes>

<NewCustomerPartnerID>1234567890</NewCustomerPartnerID>
<NewCustomerPartnerKey>abcdefghijk</NewCustomerPartnerKey>

4.2 GENERATEBUSINESSPACK

Metoda stuzy do awizowania podstawowej przesytki ORLEN Paczka.

4.21

Parametry wywotania:

18
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Identyfikator Klienta nadany

<PartnerID> przez ORLEN Paczka (REQUIRED)10 char
Hasto Klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED)10 char

<DestinationCode>

Kod POPeR

(REQUIRED)15 char

<AlternativeDestinationCode> Alternatywny kod POPeR 15 char
<ReturnDestinationCode> Kod POPeR do zwrotu 15 char
<BoxSize> Wielkos$¢ paczki (REQUIRED) 1 char
<PackValue> Wartosc¢ przesytki (w groszach) 6 char
Raczkaza-pebraniem (rozdziat
<CashOnDelivery> 3.12)
Kwota-pebrania-fwgroszach}

<AmountCashOnDelivery>

(rozdziat 3.12)

<Insurance>

Ubezpieczenie paczki

(true/false) boolean

<EMail> Adres email odbiorcy 60 char
<FirstName> Imie odbiorcy 30 char
<LastName> Nazwisko odbiorcy 30 char
<CompanyName> Firma odbiorcy 70 char
<StreetName> Ulica z adresu odbiorcy 30 char
Numer budynku z adresu
<BuildingNumber> odbiorcy 10 char
Numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> Miasto z adresu odbiorcy 30 char
<PostCode> Kod pocztowy z adresu odbiorcy 6 char
(REQUIRED)
9 char — numer bez prefixu +48
<PhoneNumber> Numer telefonu odbiorcy 12 char — numer z prefixem +48

<SenderEMail>

Adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> Firma nadawcy 70 char
<SenderStreetName> Ulica z adresu nadawcy (REQUIRED)30 char

Numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED)10 char
Numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity> Miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> Kod pocztowy z adresu nadawcy | (REQUIRED) 6 char

(REQUIRED)

9 char — numer bez prefixu +48
<SenderPhoneNumber> Numer telefonu nadawcy 12 char — numer z prefixem +48
<SenderOrders> Dane referencyjne 30 char
<ReturnEMail > Adres email do zwrotu 60 char
<ReturnFirstName> Imie osoby do zwrotu 30 char
<ReturnLastName> Nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> Nazwa firm do zwrotu 70 char
<ReturnStreetName> Ulica z adresu do zwrotu 30 char

Numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char
Numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> Miasto z adresu do zwrotu 30 char
<ReturnPostCode> Kod pocztowy z adresu do zwrotu | 6 char
<ReturnPhoneNumber> Numer telefonu do zwrotu 9 char — numer bez prefixu +48
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12 char — numer z prefixem +48

<PrintAdress>

Wybadr adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

<ReturnPack> Paczka zwrotna (T -jesli zwrotna) 1 char
Tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char
Mozliwos¢ nadania paczki
<ReturnAvailable> zwrotnej (T -jesli tak) 1 char
<ReturnQuantity> Liczba paczek zwrotnych 1 char

TransferDescription nie moze zawierac znakdw specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, jesli nie podano wartosci w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartosci w polu

<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L. W przeciwnym razie dla paczki zostanie przypisany rozmiar M.

Przyktad z minimalng wymagana lista pdl:

<PartnerlD>1234567890</Partner|D>
<PartnerKey>abcdefghijk</PartnerKey>
<DestinationCode>XX-142450-00-00</DestinationCode>

<FirstName>Jan</FirstName>

<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>

<SenderStreetName>Prosta</SenderStreetName>

<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>

<PrintAdress>1</PrintAdress>

Zwracane wartosci:

422 Odpowiedz

<Err>

Numer btedu

<ErrDes>

Opis btedu

<PackCode_RUCH>

Numer EAN-13 przesytki

<DestinationCode>

Kod POPER (potwierdzenie lub zmiana)

<Destinationld>

Kod PSD

<PackPrice>

Cena przesytki (w groszach)
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| <PackPaid>

Optacenie przesytki (true/false)

Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>

<PackCode_RUCH>2900000000230</PackCode_RUCH>
<DestinationCode>XX-142450-00-00</DestinationCode>
<Destinationld>142450</Destinationld>

<PackPrice>745</PackPrice>
<PackPaid>false</PackPaid>

4.3 GENERATEBUSINESSPACKTWO

Metoda stuzy do awizowania podstawowej podpisanej przesytki ORLEN Paczka.

Parametry wywotania:

431 Wywolanie

Identyfikator Klienta nadany

<PartnerID> przez ORLEN Paczka (REQUIRED) 10 char
Hasto Klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
(REQUIRED)
9 char — numer bez prefixu +48
<PhoneNumber> Numer telefonu odbiorcy 12 char — numer z prefixem +48

<DestinationCode>

Kod POPeR

(REQUIRED) 15 char

<AmountCashOnDelivery>

(rozdziat 3.12)

<AlternativeDestinationCode> Alternatywny kod POPeR 15 char
<BoxSize> Wielkos¢ paczki (REQUIRED) 1 char
<PackValue> Wartosc¢ przesytki (w groszach) 6 char
Raczkaza-pebraniem (rozdziat
<CashOnDelivery> 3.12)
Kwotapobrania{wgroszach}

<Insurance>

Ubezpieczenie paczki

(true/false) boolean

<EMail> Adres email odbiorcy 60 char

<FirstName> Imie odbiorcy 30 char

<LastName> Nazwisko odbiorcy 30 char

<CompanyName> Firma odbiorcy 70 char

<StreetName> Ulica z adresu odbiorcy 30 char
Numer budynku z adresu

<BuildingNumber> odbiorcy 10 char
Numer mieszkania z adresu

<FlatNumber> odbiorcy 10 char

<City> Miasto z adresu odbiorcy 30 char

<PostCode> Kod pocztowy z adresu odbiorcy 6 char

<SenderEMail>

Adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName>

Nazwisko nadawcy

(REQUIRED) 30 char
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<SenderCompanyName>

Firma nadawcy

70 char

<SenderStreetName>

Ulica z adresu nadawcy

(REQUIRED) 30 char

Numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char
Numer mieszkania z adresu

<SenderFlatNumber> nadawcy 10 char

<SenderCity> Miasto z adresu nadawcy (REQUIRED) 30 char

<SenderPostCode> Kod pocztowy z adresu nadawcy | (REQUIRED) 6 char

(REQUIRED)

9 char — numer bez prefixu +48
<SenderPhoneNumber> Numer telefonu nadawcy 12 char — numer z prefixem +48
<SenderOrders> Dane referencyjne 30 char
<ReturnDestinationCode> Kod POPeR do zwrotu 15 char
<ReturnEMail > Adres email do zwrotu 60 char
<ReturnFirstName> Imie osoby do zwrotu 30 char
<ReturnLastName> Nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> Nazwa firm do zwrotu 70 char
<ReturnStreetName> Ulica z adresu do zwrotu 30 char

Numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

Numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> Miasto z adresu do zwrotu 30 char
<ReturnPostCode> Kod pocztowy z adresu do zwrotu | 6 char

9 char — numer bez prefixu +48
<ReturnPhoneNumber> Numer telefonu do zwrotu 12 char — numer z prefixem +48
<ReturnPack> Paczka zwrotna (T -jesli zwrotna) 1 char

<TransferDescription>

Tytut przelewu dla paczki za
pobraniem

70 char

<PrintAdress>

Wybadr adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

Mozliwo$¢ nadania paczki

<ReturnAvailable> zwrotnej (T -jesli tak) 1 char
<ReturnQuantity> Liczba paczek zwrotnych 1 char
<AutoDestinationChange> string
<ConfirmTermsOfUse> Potwierdz warunki uzytkowania string
Potwierdz otrzymywanie
<ConfirmMarketing> materiatéw reklamowych string
<CofirmMailing> Potwierdz adres email string

TransferDescription nie moze zawierac znakdéw specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, jesli nie podano wartosci w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartosci w polu

<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L. W przeciwnym razie dla paczki zostanie przypisany rozmiar M.
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Przyktad z minimalng wymagana listg pdl:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>
<FirstName>ImieOdbiorcy</FirstName>
<LastName>NazwiskoOdbiorcy</LastName>
<PhoneNumber>111222333</PhoneNumber>
<DestinationCode>XX-142450-00-00</DestinationCode>
<PrintAdress>1</PrintAdress>
<SenderEMail>mail@mail.pl</SenderEMail>
<SenderFirstName>ImieNadawcy</SenderFirstName>
<SenderLastName>NazwiskoNadawcy</SenderLastName>
<SenderStreetName>Przyktadowa</SenderStreetName>
<SenderBuildingNumber>15</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>00-000</SenderPostCode>
<SenderPhoneNumber>123123123</SenderPhoneNumber>

4.3.2 Odpowiedz

Zwracane wartosci:

<Err> Numer btedu

<ErrDes> Opis btedu

<PackCode_RUCH> Numer EAN-13 przesytki

<DestinationCode> Kod POPER (potwierdzenie lub zmiana)

<Destinationld> Kod PSD

<PackPrice> Cena przesytki (w groszach)

<PackPaid> Optacenie przesytki (true/false)
Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>2100123123123</PackCode_RUCH>
<DestinationCode>XX-142450-00-00</DestinationCode>
<Destinationld>142450</Destinationld>

<PackPrice>849</PackPrice>

<PackPaid>true</PackPaid>

<NameCL>WARSZAWA</NameCL>

<NrCL>0130</NrCL>
<OriginDestinationCode>XX-142450-00-00</0OriginDestinationCode>
<AutoChangeDestinationConfirm>0</AutoChangeDestinationConfirm>

44 GENERATELABELBUSINESSPACK

Metoda stuzy do awizowania przesytki ORLEN Paczka, w odpowiedzi zwraca etykiete w PDF.
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Parametry wywotania:

441 Wywolanie

Identyfikator Klienta nadany przez

<PartnerlD> ORLEN Paczka (REQUIRED) 10 char
Hasto Klienta nadane przez ORLEN
<PartnerKey> Paczka (REQUIRED) 10 char

<DestinationCode>

Kod POPeR

(REQUIRED) 15 char

<AlternativeDestinationCode> Alternatywny kod POPeR 15 char

<BoxSize> Wielkos¢ paczki (REQUIRED) 1 char

<PackValue> Wartosc¢ przesytki (w groszach) 6 char

<CashOnDelivery> Paczkaza-pobraniem (rozdziat 3.12)
Kwota-pobrania-{wgroszach}

<AmountCashOnDelivery>

(rozdziat 3.12)

<Insurance>

Ubezpieczenie paczki

(true/false) boolean

<EMail> Adres email odbiorcy 60 char
<FirstName> Imie odbiorcy 30 char
<LastName> Nazwisko odbiorcy 30 char
<CompanyName> Firma odbiorcy 70 char
<StreetName> Ulica z adresu odbiorcy 30 char
<BuildingNumber> Numer budynku z adresu odbiorcy 10 char
<FlatNumber> Numer mieszkania z adresu odbiorcy | 10 char
<City> Miasto z adresu odbiorcy 30 char
<PostCode> Kod pocztowy z adresu odbiorcy 6 char
(REQUIRED)
9 char — numer bez prefixu +48
<PhoneNumber> Numer telefonu odbiorcy 12 char — numer z prefixem +48

<SenderEMail>

Adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> Firma nadawcy 70 char
<SenderStreetName> Ulica z adresu nadawcy (REQUIRED) 30 char

<SenderBuildingNumber>

Numer budynku z adresu nadawcy

(REQUIRED) 10 char

<SenderFlatNumber>

Numer mieszkania z adresu nadawcy

10 char

<SenderCity> Miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> Kod pocztowy z adresu nadawcy (REQUIRED) 6 char

(REQUIRED)

9 char — numer bez prefixu +48
<SenderPhoneNumber> Numer telefonu nadawcy 12 char — numer z prefixem +48
<SenderOrders> Dane referencyjne 30 char
<ReturnDestinationCode> Kod POPeR do zwrotu 15 char
<ReturnEMail > Adres email do zwrotu 60 char
<ReturnFirstName> Imie osoby do zwrotu 30 char
<ReturnLastName> Nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> Nazwa firm do zwrotu 70 char
<ReturnStreetName> Ulica z adresu do zwrotu 30 char
<ReturnBuildingNumber> Numer budynku z adresu do zwrotu | 10 char

Numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> Miasto z adresu do zwrotu 30 char
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<ReturnPostCode> Kod pocztowy z adresu do zwrotu 6 char

9 char — numer bez prefixu +48

<ReturnPhoneNumber> Numer telefonu do zwrotu 12 char — numer z prefixem +48
<ReturnPack> Paczka zwrotna (T -jesli zwrotna) 1 char

Tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char

Wybor adresu do wydruku przy
zwrocie (1- adres nadania, 2 - adres

<PrintAdress> zwrotu) (REQUIRED) 1 char
Mozliwos¢ nadania paczki zwrotnej

<ReturnAvailable> (T -jesli tak) 1 char

<ReturnQuantity> Liczba paczek zwrotnych 1 char

Wybar etykiety do wydruku (1-
petny adres, 2- adres anonimowy,
<PrintType> 3- tylko nazwa odbiorcy i nadawcy) | (REQUIRED) 1 char

TransferDescription nie moze zawiera¢ znakoéw specjalnych.
Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartosé¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu
<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego
PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,
M lub L. W przeciwnym razie dla paczki zostanie przypisany rozmiar M.

Przyktad z minimalng wymagana lista pal:
<PartnerlD>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>
<DestinationCode>XX-142450-00-00</DestinationCode>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>
<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>
<PrintAdress>1</PrintAdress>
<PrintType>1</PrintType>

44.2 Odpowiedz

Etykieta w formacie PDF zwracana jest w tagu <LabelData>.

Zwracane wartosci:

<Err> Numer btedu
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<ErrDes> Opis btedu
<PackCode_RUCH> Numer EAN-13 przesytki
<DestinationCode> Kod POPER (potwierdzenie lub zmiana)
<Destinationld> Kod PSD
<PackPrice> Cena przesytki (w groszach)
<PackPaid> Optacenie przesytki true/false
<LabelData> Etykieta PDF (Base 64)
Przyktad:
<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>2100123123123</PackCode_RUCH>
<DestinationCode>XX-142450-00-00</DestinationCode>
<Destinationld>142450</Destinationld>
<PackPrice>745</PackPrice>
<PackPaid>false</PackPaid>

<LabelData>etykieta zakodowana w BASE64</LabelData>

Przyktadowy kod c# z wywotaniem Web serwisu:
PwR.WebServicePwRTest service = new PwWR.WebServicePwRTest();
service.UseDefaultCredentials = true;
byte[] data;

service.GeneratelLabelBusinessPack("<user>", "<password>", "<destination code>", null, null, null, null,
null, null, null, "<first name>","last name",

"<company>", "<address>", "<number>", null, "<city>", "<postal code>", "<phone>", "<email>",
null, null, "<sender company>", "<adress>", "number", null, "<city>", "<postal code>",
"<sender phone>", null, null, null, null, null, null, null, null, null, null, null, null, null, null, "1", null,
null, "1", out data);

if (data = null)

{

File.WriteAlIBytes("c:\\Paczka_test\\label.pdf", data);}

4.5 GENERATELABELBUSINESSPACKLIST

Metoda stuzy do awizowania pojedynczej paczki lub listy przesytek ORLEN Paczka, w odpowiedzi
zwraca etykiete w PDF, PDF10, EPL. Maksymalna ilo$¢ jednorazowo zwrdconych etykiet wynosi 50.
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Parametry wywotania:

451 Wywolanie

Identyfikator klienta nadany

epl)

<PartnerID> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED) 10 char

<Format> Format etykiety (pdf, pdf10 lub (REQUIRED) 3 char

BusinessPackList

Struktura ,businesspack” do listy
paczek

(REQUIRED) (ilogé: 1 ... 50)

BusinessPack struktura

<AmountCashOnDelivery>

(rozdziat 3.12)

<DestinationCode> Kod POPeR (REQUIRED) 15 char
<AlternativeDestinationCode> Alternatywny kod POPeR 15 char
<ReturnDestinationCode> Kod POPeR do zwrotu 15 char
<BoxSize> Wielkos¢ paczki (REQUIRED) 1 char
<PackValue> Wartos¢ przesytki (w groszach) 6 char
Paczkaza-pebraniem (rozdziat
<CashOnDelivery> 3.12)
kwota-pobrania{w-groszach}

<Insurance>

Ubezpieczenie paczki

(true/false) boolean

<EMail> Adres email odbiorcy 60 char
<FirstName> Imie odbiorcy 30 char
<LastName> Nazwisko odbiorcy 30 char
<CompanyName> Firma odbiorcy 70 char
<StreetName> Ulica z adresu odbiorcy 30 char
Numer budynku z adresu
<BuildingNumber> odbiorcy 10 char
Numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> Miasto z adresu odbiorcy 30 char
<PostCode> Kod pocztowy z adresu odbiorcy 6 char
(REQUIRED)
9 char — numer bez prefixu +48
<PhoneNumber> Numer telefonu odbiorcy 12 char — numer z prefixem +48

<SenderEMail>

Adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> Firma nadawcy 70 char
<SenderStreetName> Ulica z adresu nadawcy (REQUIRED) 30 char

Numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char
Numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity> Miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> Kod pocztowy z adresu nadawcy | (REQUIRED) 6 char

(REQUIRED)

9 char — numer bez prefixu +48
<SenderPhoneNumber> Numer telefonu nadawcy 12 char — numer z prefixem +48
<SenderOrders> Dane referencyjne 30 char

<ReturnEMail >

Adres email do zwrotu

60 char
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<ReturnFirstName>

Imie osoby do zwrotu

30 char

<ReturnLastName> Nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> Nazwa firm do zwrotu 70 char
<ReturnStreetName> Ulica z adresu do zwrotu 30 char

Numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

Numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> Miasto z adresu do zwrotu 30 char
<ReturnPostCode> Kod pocztowy z adresu do zwrotu | 6 char

9 char — numer bez prefixu +48

<ReturnPhoneNumber> Numer telefonu do zwrotu 12 char — numer z prefixem +48
<ReturnPack> Paczka zwrotna (t -jesli zwrotna) 1 char

<PrintAdress>

Wybér adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

Wyboér etykiety do wydruku (1-
petny adres, 2- adres
anonimowy, 3- tylko nazwa

<PrintType> odbiorcy i nadawcy) (REQUIRED) 1 char
Tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char
Mozliwos¢ nadania paczki
<ReturnAvailable> zwrotnej (t -jesli tak) 1 char
<ReturnQuantity> Liczba paczek zwrotnych 1 char

TransferDescription nie moze zawiera¢ znakoéw specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartos¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu

<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktédrym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L. W przeciwnym razie dla paczki zostanie przypisany rozmiar M.

Przyktad z minimalng wymagana listg pol:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>

<Format>PDF</Format>
<BusinessPackList>

<BusinessPack>

<DestinationCode>XX-142450-00-00 </DestinationCode>

<FirstName>Jan</FirstName>

<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>
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<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>
<SenderOrders>dane referencyjne</ SenderOrders>
<PrintAdress>1</PrintAdress>

<PrintType>1</PrintType>

</BusinessPack>

</BusinessPackList>

452 Odpowiedz

Etykieta zwracana jest w tagu <LabelData>.
Zwracane wartosci:

<GeneratelabelBusinessPackList> - lista paczek (1 ... n)

<Err> Numer btedu

<ErrDes> Opis btedu

<PackCode_RUCH> Numer EAN-13 przesytki
<DestinationCode> Kod POPER (potwierdzenie lub zmiana)
<Destinationld> Kod PSD

<PackPrice> Cena przesytki (w groszach)

<PackPaid> Optacenie przesytki true/false
<SenderOrders> Dane referencyjne

<GeneratelabelBusinessPackList>
| <LabelData> Etykieta PDF, PDF10, EPL (Base 64)

Przykiad:
<GeneratelabelBusinessPackList>

<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>2100123123123</PackCode_RUCH>
<DestinationCode>XX-142450-00-00</DestinationCode>
<Destinationld>142450</Destinationld>
<PackPrice>745</PackPrice>
<PackPaid>false</PackPaid>

<SenderOrders>dane referencyjne</SenderOrders>

</GeneratelLabelBusinessPackList>

<LabelData>etykieta zakodowana w BASE64</LabelData>
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4.6 GENERATELABELBUSINESSPACKLISTTWO

Metoda stuzy do awizowania pojedynczej paczki lub listy przesytek ORLEN Paczka, w odpowiedzi
zwraca etykiete w PDF, PDF10, EPL, ZPL, ZPL300 DPI.
Maksymalna ilo$¢ jednorazowo zwrdconych etykiet wynosi 50.

Parametry wywotania:

4.6.1 Wywolanie

Identyfikator klienta nadany

zpl lub zpl_300dpi)

<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED) 10 char

<Format> Format etykiety (pdf, pdf10, epl, (REQUIRED) 10 char

BusinessPackList

Struktura ,businesspack” do listy
paczek

(REQUIRED) (ilos¢ 1 ... 50)

BusinessPack struktura

<DestinationCode>

Kod POPeR

(REQUIRED) 15 char

<AmountCashOnDelivery>

(rozdziat 3.12)

<AlternativeDestinationCode> Alternatywny kod POPeR 15 char
<BoxSize> Wielko$¢ paczki (REQUIRED) 1 char
<PackValue> Wartosc¢ przesytki (w groszach) 6 char
Raczkaza-pebraniem (rozdziat
<CashOnDelivery> 3.12)
kwota-pobrania{w-groszach}

<Insurance>

Ubezpieczenie paczki

(true/false) boolean

<EMail> Adres email odbiorcy 60 char
<FirstName> Imie odbiorcy 30 char
<LastName> Nazwisko odbiorcy 30 char
<CompanyName> Firma odbiorcy 70 char
<StreetName> Ulica z adresu odbiorcy 30 char
Numer budynku z adresu
<BuildingNumber> odbiorcy 10 char
Numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> Miasto z adresu odbiorcy 30 char
<PostCode> Kod pocztowy z adresu odbiorcy 6 char
(REQUIRED)
9 char — numer bez prefixu +48
<PhoneNumber> Numer telefonu odbiorcy 12 char — numer z prefixem +48

<SenderEMail>

Adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> Firma nadawcy 70 char
<SenderStreetName> Ulica z adresu nadawcy (REQUIRED) 30 char

<SenderBuildingNumber>

Numer budynku z adresu
nadawcy

(REQUIRED) 10 char
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<SenderFlatNumber>

Numer mieszkania z adresu
nadawcy

10 char

<SenderCity> Miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> Kod pocztowy z adresu nadawcy | (REQUIRED) 6 char

(REQUIRED)

9 char — numer bez prefixu +48
<SenderPhoneNumber> Numer telefonu nadawcy 12 char — numer z prefixem +48
<SenderOrders> Dane referencyjne 30 char

<ReturnDestinationCode> Kod POPeR do zwrotu 15 char
<ReturnEMail > Adres email do zwrotu 60 char
<ReturnFirstName> Imie osoby do zwrotu 30 char
<ReturnLastName> Nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> Nazwa firm do zwrotu 70 char
<ReturnStreetName> Ulica z adresu do zwrotu 30 char

Numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

Numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> Miasto z adresu do zwrotu 30 char
<ReturnPostCode> Kod pocztowy z adresu do zwrotu | 6 char

9 char — numer bez prefixu +48

<ReturnPhoneNumber> Numer telefonu do zwrotu 12 char — numer z prefixem +48
<ReturnPack> Paczka zwrotna (t -jesli zwrotna) 1 char

<TransferDescription>

Tytut przelewu dla paczki za
pobraniem

70 char

<PrintAdress>

Wybér adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

<ReturnAvailable>

Mozliwos¢ nadania paczki
zwrotnej (t -jesli tak)

1 char

<ReturnQuantity>

Liczba paczek zwrotnych

1 char

<PrintType>

Wybaor etykiety do wydruku (1-
petny adres, 2- adres
anonimowy, 3- tylko nazwa
odbiorcy i nadawcy)

(REQUIRED) 1 char

TransferDescription nie moze zawiera¢ znakdéw specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartos¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu

<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L. W przeciwnym razie dla paczki zostanie przypisany rozmiar M.

Przyktad z minimalng wymagana listg pdl:
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<PartnerID>1234567890</PartnerlD>
<PartnerKey>abcdefghijk</PartnerKey>
<Format>PDF</Format>
<BusinessPackList>

<BusinessPack>
<DestinationCode>XX-142450-00-00</DestinationCode>
<BoxSize></BoxSize>

<PackValue>899</PackValue>
<EMail>test@mail.com</EMail>
<FirstName>Zenon</FirstName>
<LastName>Zenonowicz</LastName>
<CompanyName></CompanyName>
<StreetName>Testowinska</StreetName>
<BuildingNumber>7</BuildingNumber>
<City>Warszawa</City>
<PostCode>00-000</PostCode>
<PhoneNumber>111555899</PhoneNumber>
<SenderEMail>nadawca@test.com</SenderEMail>
<SenderFirstName>test</SenderFirstName>
<SenderLastName>test</SenderLastName>
<SenderStreetName>Stalowa</SenderStreetName>
<SenderBuildingNumber>89</SenderBuildingNumber>
<SenderPostCode>00-001</SenderPostCode>
<SenderPhoneNumber>999666333</SenderPhoneNumber>
<PrintAdress>1</PrintAdress>
<PrintType>1</PrintType>

</BusinessPack>

</BusinesPackList>

4.6.2 Odpowiedz

Etykieta zwracana jest w tagu <LabelData>.
Zwracane wartosci:

<GeneratelabelBusinessPackListTwo> - lista paczek (1 ... n)

<Err> Numer btedu

<ErrDes> Opis btedu

<PackCode_RUCH> Kod paczki

<DestinationCode> Kod POPeR punktu docelowego
<DestinationID> Kod PSD

<PackPrice> Cena paczki w groszach
<PackPaid> Czy paczka jest optacona
<ReturnDestinationld> Kod PSD punktu zwrotu
<ReturnDestinationCode> Kod POPeR punktu zwrotu
<NameCL> Numer
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<NrCL>

Kod regionu punktu docelowego

<OriginDestinationCode>

Kod POPeR punktu nadania

<AutoChangeDestinationConfirm>

Olub1

<GeneratelLabelBusinessPackListTwo>

| <LabelData>

Etykieta PDF, PDF10, EPL, ZPL, ZPL 300 DPI (Base 64) |

Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>

<PackCode_RUCH>2100123123123</PackCode_RUCH>
<DestinationCode>XX-142450-00-00</DestinationCode>
<Destinationld>142450</Destinationld>

<PackPrice>849</PackPrice>
<PackPaid>true</PackPaid>

<NameCL>WARSZAWA</NameCL>

<NrCL>0130</NrCL>

<OriginDestinationCode>XX-142450-00-00</OriginDestinationCode>
<AutoChangeDestinationConfirm>0</AutoChangeDestinationConfirm>

4.7 GENERATELABELBUSINESSPACKTWO

Metoda stuzy do awizowania przesytki ORLEN Paczka, w odpowiedzi zwraca etykiete w PDF.

Parametry wywotania:

471 Wywolanie

Identyfikator klienta nadany

<AmountCashOnDelivery>

<PartnerID> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<DestinationCode> Kod POPeR (REQUIRED) 15 char
<AlternativeDestinationCode> Alternatywny kod POPeR 15 char
<BoxSize> Wielkos¢ paczki (REQUIRED) 1 char
<PackValue> Wartosc¢ przesytki (w groszach) 6 char
Paczkaza-pebraniem (rozdziat
<CashOnDelivery> 3.12)
kwota-pebrania{w-groszach}

(rozdziat 3.12)

<Insurance>

Ubezpieczenie paczki

(true/false) boolean

<EMail> Adres email odbiorcy 60 char
<FirstName> Imie odbiorcy 30 char
<LastName> Nazwisko odbiorcy 30 char
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<CompanyName> Firma odbiorcy 70 char
<StreetName> Ulica z adresu odbiorcy 30 char
Numer budynku z adresu
<BuildingNumber> odbiorcy 10 char
Numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> Miasto z adresu odbiorcy 30 char
<PostCode> Kod pocztowy z adresu odbiorcy 6 char
(REQUIRED)
9 char — numer bez prefixu +48
<PhoneNumber> Numer telefonu odbiorcy 12 char — numer z prefixem +48

<SenderEMail>

Adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> Firma nadawcy 70 char
<SenderStreetName> Ulica z adresu nadawcy (REQUIRED) 30 char

Numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char
Numer mieszkania z adresu

<SenderFlatNumber> nadawcy 10 char

<SenderCity> Miasto z adresu nadawcy (REQUIRED) 30 char

<SenderPostCode> Kod pocztowy z adresu nadawcy | (REQUIRED) 6 char

(REQUIRED)

9 char — numer bez prefixu +48
<SenderPhoneNumber> Numer telefonu nadawcy 12 char — numer z prefixem +48
<SenderOrders> Dane referencyjne 30 char
<ReturnDestinationCode> Kod POPeR do zwrotu 15 char
<ReturnEMail > Adres email do zwrotu 60 char
<ReturnFirstName> Imie osoby do zwrotu 30 char
<ReturnLastName> Nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> Nazwa firm do zwrotu 70 char
<ReturnStreetName> Ulica z adresu do zwrotu 30 char

Numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

Numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> Miasto z adresu do zwrotu 30 char
<ReturnPostCode> Kod pocztowy z adresu do zwrotu | 6 char

9 char — numer bez prefixu +48
<ReturnPhoneNumber> Numer telefonu do zwrotu 12 char — numer z prefixem +48
<ReturnPack> Paczka zwrotna (t -jesli zwrotna) 1 char

<TransferDescription>

Tytut przelewu dla paczki za
pobraniem

70 char

<PrintAdress>

Wybor adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

<ReturnAvailable>

Mozliwos¢ nadania paczki
zwrotnej (t -jesli tak)

1 char

<ReturnQuantity>

Liczba paczek zwrotnych

1 char

<PrintType>

Wybadr etykiety do wydruku (1-
petny adres, 2- adres
anonimowy, 3- tylko nazwa
odbiorcy i nadawcy)

(REQUIRED) 1 char

<AutoDestinationChange>

string
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TransferDescription nie moze zawiera¢ znakow specjalnych.
Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartos¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu
<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego
PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,
M lub L. W przeciwnym razie dla paczki zostanie przypisany rozmiar M.

Przyktad z minimalng wymagana lista pdl:

<PartnerlD>1234567890</PartnerlD>
<PartnerKey>abcdefghijk</PartnerKey>
<DestinationCode>XX-142450-00-00</DestinationCode>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>
<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>
<PrintAdress>1</PrintAdress>

<PrintType>1</PrintType>

4.7.2 Odpowiedz

Etykieta w formacie PDF zwracana jest w tagu <LabelData>.

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
<PackCode_RUCH> Numer EAN-13 przesytki
<DestinationCode> Kod POPER (potwierdzenie lub zmiana)
<Destinationld> Kod PSD
<PackPrice> Cena przesytki (w groszach)
<PackPaid> Optacenie przesytki true/false
<LabelData> Etykieta PDF (Base 64)

Przyktad:
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<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>2100123123123</PackCode_RUCH>
<DestinationCode>XX-142450-00-00</DestinationCode>
<Destinationld> 142450 </Destinationld>
<PackPrice>745</PackPrice>
<PackPaid>false</PackPaid>

<LabelData>etykieta zakodowana w BASE64</LabelData>

4.8 GENERATENUMBERWAYBILLS

Metoda stuzy do rezerwacji puli numeréw przesytek ORLEN Paczka.

Przekazywanie wielkosci puli rezerwowanych numeroéw listéw deklarowana jest w parametrze
NumberOfWayhbills.

Maksymalna wielkos¢ puli w jednym wywotaniu to 10000.

Zarezerwowane numery przesytek nie posiadajg terminu waznosci.

Dla zarezerwowanych numerdéw przesytek tg metoda dane awizacyjne powinny by¢ przekazywane za
pomocg metody PutCustomerPack (rozdziat 4.34)

48.1 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<NumberOfWaybills> Liczba listow do wygenerowania (REQUIRED) 5 char
Przykiad:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>
<NumberOfWaybills>2</NumberOfWaybills>

48.2 Odpowiedz

Zwracane wartosci:

| <PackCode> | Numer EAN-13 przesytki

Przykiad:

<PackCode>2100000000230</PackCode>
<PackCode>2100000000231</PackCode>
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49 GENERATEPROTOCOL

Metoda stuzy do wygenerowania Protokotu (w formacie PDF) dla wskazanych numerdw paczek
zaawizowanych do ORLEN Paczka. Dodatkowo metoda zwraca btedne paczki (wszystkie majace inny
status niz zaawizowane) oraz poprawne paczki wraz numerem protokotu.

Maksymalna ilo$¢ paczek zadeklarowanych na jednym protokole to 571.

Deklaracja paczki, ktdra zawarta ma zostac na protokole odbywa sie poprzez wprowadzenie numeru
w tagu <unsignedLong> obiektu <parcels></parcels> (maksymalna ilo$¢ tagéw <unsignedLong> to
571).

Czas zwracany w tagu <DATA_MOD> jest w strefie UTC+1 (lokalny czas polski).

491 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany
<PartnerID> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<parcels> Numery ean-13 przesytek (REQUIRED) List<unsignedLong>

Przyktad z minimalng wymagana lista pal:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>

<parcels>

<unsignedLong>2100123123123</unsignedLong>
<unsignedLong>2100123123124</unsignedLong>
<unsignedLong>2100123123125</unsignedLong>

</parcels>

49.2 Odpowiedz

Zwracane wartosci:

Protokdt w formacie PDF zwracany jest w tagu <LabelData>

<Err> Numer btedu, gdy err 210 — paczka o innym
statusie niz zaawizowana — nie zostanie dodana
do protokotu

<ErrDes> Opis btedu

<ProtocolCode> Numer protokotu (jesli err=0)

<PackCodeRUCH> Numer ean-13 przesytki

<DATA_MOD> Data modyfikacji statusu

<status> Nr statusu

<status_opis> Opis statusu
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‘ <LabelData>

Protokot w formacie pdf (base 64)

Przyktad:

Przesytka dodana do protokotu przekazania:

<Err>0</Err>
<ErrDes>0K</ErrDes>

<ProtocolCode>1000185903089</ProtocolCode>
<PackCodeRUCH>2101142967553</PackCodeRUCH>
<DATA_MOD>2024-10-22T13:12:55+02:00</DATA_MOD>

<status>200</status>

<status_opis>Brak Paczki</status_opis>

Przesytka nie dodana do protokotu przekazania:

<Err>210</Err>

<ErrDes>NIE DODANE DO PROTOKOtU</ErrDes>
<PackCodeRUCH>2101142967553</PackCodeRUCH>
<DATA_MOD>2024-10-22T13:15:12+02:00</DATA_MOD>

<status>201</status>

<status_opis>Brak Paczki</status_opis>

Przesytka nie dodana do protokotu przekazania:

<Err>210</Err>

<ErrDes>NIE DODANE DO PROTOKOtU</ErrDes>
<PackCodeRUCH>2101142968208</PackCodeRUCH>
<DATA_MOD>2024-10-22T13:16:20+02:00</DATA_MOD>

<status>400</status>

<status_opis>Brak Paczki</status_opis>

410 GENERATESHIPPINGCODE

Metoda stuzy do awizowania przesytki ORLEN Paczka bez etykiety (WhiteLabel).

Parametry wywotania:

410.1 Wywolanie

Identyfikator klienta nadany

<PartnerID> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
(REQUIRED)
9 char — numer bez prefixu +48
12 char — numer z prefixem +48
<PhoneNumber> Numer telefonu odbiorcy

<DestinationCode>

Kod POPeR

(REQUIRED) 15 char

<AlternativeDestinationCode> Alternatywny kod POPeR 15 char
<BoxSize> Wielko$¢ paczki (REQUIRED) 1 char
<PackValue> Wartosc¢ przesytki (w groszach) 6 char

<CashOnDelivery>

Raczkaza-pebraniem (rozdziat
3.12)
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<AmountCashOnDelivery>

Kwota-pobranio-tw-greszach}
(rozdziat 3.12)

<Insurance>

Ubezpieczenie paczki

(true/false) boolean

<EMail> Adres email odbiorcy 60 char

<FirstName> Imie odbiorcy 30 char

<LastName> Nazwisko odbiorcy 30 char

<CompanyName> Firma odbiorcy 70 char

<StreetName> Ulica z adresu odbiorcy 30 char
Numer budynku z adresu

<BuildingNumber> odbiorcy 10 char
Numer mieszkania z adresu

<FlatNumber> odbiorcy 10 char

<City> Miasto z adresu odbiorcy 30 char

<PostCode> Kod pocztowy z adresu odbiorcy 6 char

<SenderEMail>

Adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> Firma nadawcy 70 char
<SenderStreetName> Ulica z adresu nadawcy (REQUIRED) 30 char

Numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED) 10 char
Numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity> Miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> Kod pocztowy z adresu nadawcy | (REQUIRED) 6 char

(REQUIRED)

9 char — numer bez prefixu +48

12 char — numer z prefixem +48
<SenderPhoneNumber> Numer telefonu nadawcy
<SenderOrders> Dane referencyjne 30 char
<ReturnDestinationCode> Kod POPeR do zwrotu 15 char
<ReturnEMail > Adres email do zwrotu 60 char
<ReturnFirstName> Imie osoby do zwrotu 30 char
<ReturnLastName> Nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> Nazwa firm do zwrotu 70 char
<ReturnStreetName> Ulica z adresu do zwrotu 30 char

Numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char
Numer mieszkania z adresu do

<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> Miasto z adresu do zwrotu 30 char
<ReturnPostCode> Kod pocztowy z adresu do zwrotu | 6 char

9 char — numer bez prefixu +48
<ReturnPhoneNumber> Numer telefonu do zwrotu 12 char — numer z prefixem +48
<ReturnPack> Paczka zwrotna (t -jesli zwrotna) 1 char

<TransferDescription>

Tytut przelewu dla paczki za
pobraniem

70 char

<PrintAdress>

Wybadr adresu do wydruku przy
zwrocie (1- adres nadania, 2 -
adres zwrotu)

(REQUIRED) 1 char

<ReturnAvailable>

Mozliwo$¢ nadania paczki
zwrotnej (t -jesli tak)

1 char

<ReturnQuantity>

Liczba paczek zwrotnych

1 char
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TransferDescription nie moze zawiera¢ znakow specjalnych.
Pola <FirstName> i <LastName> sg obowigzkowe, chyba, ze podano wartos¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu
<SenderCompanyName>.

Pole <ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego
PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,
M lub L. W przeciwnym razie dla paczki zostanie przypisany rozmiar M.

Przyktad z minimalng wymagana lista pdl:

<PartnerID>1234567890</Partner|D>
<PartnerKey>abcdefghijk</PartnerKey>
<DestinationCode>XX-142450-00-00</DestinationCode>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>
<SenderStreetName>Prosta</SenderStreetName>
<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>

<PrintAdress>1</PrintAdress>

4.10.2 Odpowiedz

Kod nadania przesytki zwracany jest w tagu <ShippingCode>.

Zwracane wartosci:

<Err> Numer btedu

<ErrDes> Opis btedu

<ShippingCode> Kod nadania przesytki
<DestinationCode> Kod POPER (potwierdzenie lub zmiana)
<DestinationID> Kod PSD

<PackPrice> Cena przesytki (w groszach)
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| <PackPaid>

Optacenie przesytki true/false

Przykiad:

<Err>000</Err>
<ErrDes>saved</ErrDes>

<ShippingCode>1234567</ShippingCode>
<DestinationCode>XX-142450-00-00</DestinationCode>
<Destinationld>142450</Destinationld>

<PackPrice>745</PackPrice>
<PackPaid>false</PackPaid>

411 GETGENERATEDPARCELS

Metoda stuzy do pobierania numerdéw zaawizowanych paczek wraz z datg ich awizacji dla podanego

zakresu dat. W odpowiedzi zostang przekazane numery paczek nie starsze niz zaawizowane 30 dni

wczesniej.

Czas zwracany w tagu <Data> jest w strefie UTC+1 (lokalny czas polski).

Parametry wywotania:

4111 Wywolanie

Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<dateFrom> Data poczatkowa (YYYY-MM-DD) dateTime
<dateTo> Data koncowa (YYYY-MM-DD) dateTime

Przyktad z minimalng wymagana listg pdl:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>
<dateFrom>2024-07-01</dateFrom>
<dateT0>2024-07-15</dateTo>

Zwracane wartosci:

4.11.2 Odpowiedz

<GetGeneratedParcels> - lista paczek (1 ... n)

<Err>

Numer btedu

<ErrDes>

Opis btedu

<PackCode_RUCH>

Numery EAN-13 przesytek

<Data>

Data zaawizowania przesytki

41

AP|_ORLENPaczka_v_1 26 002



Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>
<PackCode_RUCH>2100123123123</PackCode_RUCH>
<Data>2024-07-01T00:13:33.757+02:00</Data>

412 GIVECURRENTPACK

Metoda stuzy do pobierania aktualnego numeru paczki w przypadku, gdy do paczki pierwotnej
zostata wygenerowana etykieta zwrotna.

4121 Wywotanie

Parametry wywotania:

<packCode> numer przesytki ‘ (REQUIRED) 13 char

Przyktad z minimalng wymagana lista pol:
<packCode> 2100123123123</packCode>

412.2 Odpowiedz

Zwracane wartosci:

<GiveCurrentPackResult>string</GiveCurrentPackResult>

| GiveCurrentPackResult | Aktualny numer paczki

Przyktad:

<GiveCurrentPackResult>2600123123123</GiveCurrentPackResult>

413 GIVEMASTERPACK

Metoda stuzy do pobierania pierwotnego numeru paczki w przypadku, gdy otrzymalismy numer
paczki zwrotne;.

413.1 Wywolanie

Parametry wywotania:

<packCode> numer przesytki ‘ (REQUIRED) 13 char
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Przyktad z minimalng wymagana listg pdl:

<packCode>2600123123123</packCode>

Zwracane wartosci:

413.2 Odpowiedz

<GiveMasterPackResult>string</GiveMasterPackResult>

‘ GiveMasterPackResult

Numer paczki pierwotnej

Przyktad:

<GiveMasterPackResult>2100123123123</GiveMasterPackResult>

414 GIVEMEALLPSDLOCATION

Metoda nieaktywna od 01.01.2025 ze wzgledu na zamkniecie punktéw PSD oraz wytgczenie ustugi

COD.

Lista wszystkich Kioskdéw w ramach ustugi ORLEN Paczka z rozszerzonym opisem lokalizacji.

Parametry wywotania:

4141 Wywolanie

Identyfikator klienta nadany

<PartnerID> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED) 10 char

Przyktad z minimalng wymagana listg pél:

<PartnerlD>1234567890</Partner|D>
<PartnerKey>abcdefghijk</PartnerKey>

Zwracane wartosci:

414.2 Odpowiedz

<DestinationCode> Kod POPeR 15 char
Ulica, na ktdérej miesci sie punkt
<StreetName> odbioru paczek 50 char
<BuildingNumber> Numer budynku, numer lokalu 15 char
<City> Miasto, gdzie miesci sie pop 40 char
<District> Dzielnica, gdzie miesci sie pop 30 char
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<Latitude> Szerokosc¢ geograficzna pop 10 char

<Longitude> Dtugos¢ geograficzna pop 10 char

<Province> Wojewddztwo 20 char
o bran

<CashOnDelivery> (rozdziat 3.12) (false) boolean
Informacja o godzinach otwarcia

<OpeningHours> pop 50 char
Opis lokalizacji punktu odbioru

<Location> paczek 255 char

<PSD> Nr PSD 6 char

<Available> Czy pop jest dostepny t/n 1 char

Przyktad:

<DestinationCode>RZ-395162-KK-35</DestinationCode>
<StreetName>WARSZAWSKA 75A</StreetName>
<BuildingNumber>82</BuildingNumber>
<City>Rzeszow</City>

<District>Rzeszéw</District>
<Longitude>21.99427</Longitude>
<Latitude>50.05775</Latitude>
<Province>Podkarpackie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:00:00-24:00, S0:00:00-24:00, Nd:00:00-24:00</OpeningHours>
<Location>Automat paczkowy obok sklepu</Location>
<PSD>395162</PSD>

<Available>T</Available>

<PointType>PKN</PointType>

415 GIVEMEALLLOCATIONWITHALLDATA

Metoda zwraca rozszerzone dane dla wszystkich punktéw (APM, PKN, PSD, PPP, PPK) dostepnych w
ustudze ORLEN Paczka.

4151 Wywolanie

Parametry wywotania:

BRAK

415.2 Odpowiedz

Zwracane wartosci:

<DestinationCode> | Kod POPeR 15 char
<StreetName> Ulica z adresu odbiorcy 50 char
<BuildingNumber> | Numer budynku, numer lokalu 15 char
<City> Miasto z adresu odbiorcy 40 char
<District> Dzielnica 30 char
<Longitude> Dtugosé geograficzna 10 char
<Latitude> Szerokosc¢ geograficzna 10 char
<Province> Wojewddztwo 20 char
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<CashOnDelivery> Czyjestustuga-pebraniewa (rozdziat 3.12) (false) boolean
<OpeningHours> Godziny otwarcia punktu odbioru 50 char
<Location> Opis lokalizacji punktu odbioru 255 char
<PSD> Unikatowy 6-cyfrowy numer id punktu odbioru 6 char
<Available> Czy punkt jest dostepny w ustudze orlen paczka (T/N) 1 char
<Obszar> Obszar punktu odbioru 20 char
<Mikrorejon> Mikrorejon punktu odbioru 20 char
<Skrotnrpok> Skrét numeru id punktu odbioru 20 char
<Sortownia> Sortownia, do ktdrej przypisany jest punkt odbioru 20 char
<PointType> Rodzaj punktu (wtasny - I.DSD, partnerski — psp, ppp, psf, 3 char

ppk, automat - apm, stacja orlen — pkn)
<Presort> Presort punktu odbioru 20 char
<Cras> Parametr na potrzeby !(urle.rskle, dot. Czasu dostepnosci 20 char

punktu dla dostaw kurierskich

. Struktura ,nearestpoint” - zwraca adres trzech najblizszych

<NearestPoint> . . 3 punkty

punktéw wzgledem punktu pierwotnego

Przyktadowa odpowiedzi:

<?xml version="1.0" encoding="utf-8"?>

<soap:Envelope xmlns:soap="http://schemas.xmlsoap.org/soap/envelope/" xmlns:xsi="http://www.w3.org/20
p p p p p.org Y p p g

01/XMLSchema-instance" xmlins:xsd="http://www.w3.0rg/2001/XMLSchema">

<soap:Body>

<GiveMeAllLocationWithAllDataResponse xmlns="https://91.242.220.103/WebServicePwR">
<GiveMeAllLocationWithAllDataResult>

<xs:schema id="NewDataSet" xmlns="" xmlns:xs="http://www.w3.0rg/2001/XMLSchema" xmlIns:msd

ata="urn:schemas-microsoft-com:xml-msdata">

<xs:element name="NewDataSet" msdata:lsDataSet="true" msdata:UseCurrentLocale="true">

<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">

<xs:element name="LocationWithAllData">
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<xs:complexType>
<xs:sequence>

<xs:element name="DestinationCode" type="xs:string" minOccurs="0" />
<xs:element name="StreetName" type="xs:string" minOccurs="0" />
<xs:element name="BuildingNumber" type="xs:string" minOccurs="0" />
<xs:element name="City" type="xs:string" minOccurs="0" />
<xs:element name="District" type="xs:string" minOccurs="0" />
<xs:element name="Longitude" type="xs:string" minOccurs="0" />
<xs:element name="Latitude" type="xs:string" minOccurs="0" />
<xs:element name="Province" type="xs:string" minOccurs="0" />
<xs:element name="CashOnDelivery" type="xs:boolean" minOccurs="0" />
<xs:element name="0peningHours" type="xs:string" minOccurs="0" />
<xs:element name="Location" type="xs:string" minOccurs="0" />
<xs:element name="PSD" type="xs:string" minOccurs="0" />
<xs:element name="Available" type="xs:string" minOccurs="0" />
<xs:element name="0bszar" type="xs:string" minOccurs="0" />
<xs:element name="Mikrorejon" type="xs:string" minOccurs="0" />
<xs:element name="Skrotnrpok" type="xs:string" minOccurs="0" />
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<xs:element name="Sortownia" type="xs:string" minOccurs="0" />

<xs:element name="Presort" type="xs:string" minOccurs="0" />

<xs:element name="Czas" type="xs:string" minOccurs="0" />

<xs:element name="PointType" type="xs:string" minOccurs="0" />

<xs:element name="NearestPoints" msdata:DataType="System.Collections.Generic.Lis

t'1[[Pwr.Common.Models.NearestPoint, Pwr.Common.Models, Version=1.0.0.0, Culture=neutral, PublickeyTok
en=null]], mscorlib, Version=4.0.0.0, Culture=neutral, PublicKeyToken=b77a5c561934e089" type="xs:anyType"

minOccurs="0" />

</xs:sequence>
</xs:complexType>
</xs:element>
</xs:choice>

</xs:complexType>
</xs:element>
</xs:schema>
<diffgr:diffgram xmlIns:msdata="urn:schemas-microsoft-com:xml-msdata" xmins:diffgr="urn:schemas-

microsoft-com:xml-diffgram-v1">
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<NewDataSet xmlns="">
<LocationWithAllData diffgr:id="LocationWithAllDatal" msdata:rowOrder="0">

<DestinationCode>WS-100001-27-26</DestinationCode>
<StreetName>ANNOPOL</StreetName>
<BuildingNumber>17</BuildingNumber>
<City>Warszawa</City>
<District>Warszawa</District>
<Longitude>21.013830</Longitude>
<lLatitude>52.311519</Latitude>
<Province>Mazowieckie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:00:00-24:00, S0:00:00-24:00, Nd:00:00-24:00</OpeningHours>
<Location>Punkt testowy</Location>
<PSD>100001</PSD>
<Available>T</Available>
<Obszar>MIN</Obszar>
<Mikrorejon>WSK6</Mikrorejon>
<Skrotnrpok>K6-55</Skrotnrpok>
<Sortownia />
<Czas>XX</Czas>
<PointType>PSD</PointType>
<NearestPoints>
<NearestPoint>
<Name>Warszawa Chodecka 13 </Name>
<Distance>2179</Distance>
</NearestPoint>
<NearestPoint>
<Name>Warszawa Chodecka 13 </Name>
<Distance>2179</Distance>
</NearestPoint>
<NearestPoint>
<Name>Warszawa Chodecka 13 </Name>
<Distance>2179</Distance>
</NearestPoint>

API_ORLENPaczka_v_1 26 002



</NearestPoints>
</LocationWithAllData>

416 GIVEMEALLLOCATIONWITHALLDATAWITHZIPCODE

Metoda zwraca rozszerzone dane wraz z kodem pocztowym dla wszystkich typéw punktéw (APM,
PKN, PSD, PPP, PPK) dostepnych w ustudze ORLEN Paczka.

416.1 Wywolanie
Parametry wywotania:

BRAK

Zwracane wartosci:

4.16.2 Odpowiedz

<DestinationCode> Kod POPeR 15 char
<StreetName> Ulica z adresu odbiorcy 50 char
<BuildingNumber> Numer budynku, numer lokalu 15 char
<City> Miasto z adresu odbiorcy 40 char
<Zipcode> Kod pocztowy pop 6 char
<District> Dzielnica 30 char
<Longitude> Dtugosé geograficzna 10 char
<Latitude> Szerokosc¢ geograficzna 10 char
<Province> Wojewddztwo 20 char
<CashOnDelivery> Cayjestustugapobraniowa (rozdziat 3.12) (false) boolean
<OpeningHours> Godziny otwarcia punktu odbioru 50 char
<Location> Opis lokalizacji punktu odbioru 255 char
<PSD> Unikatowy 6-cyfrowy numer id punktu odbioru 6 char
<Available> Czy punkt jest dostepny w ustudze orlen paczka (T/N) 1 char
<Obszar> Obszar punktu odbioru 20 char
<Mikrorejon> Mikrorejon punktu odbioru 20 char
<Skrotnrpok> Skrét numeru id punktu odbioru 20 char
<Sortownia> Sortownia, do ktdrej przypisany jest punkt odbioru 20 char
. j - Dr i— ) ) ’
<PointType> Rodzaj punktu (wtasny IT’S partnerski — psp, ppp, psf 3 char
ppk, automat - apm, stacja orlen — pkn)
<Presort> Presort punktu odbioru 20 char
<Cras> Parametr,n'a potrzeby kurierskie, df)t. C?asu 20 char
dostepnosci punktu dla dostaw kurierskich
<NearestPoint> Str'uk.t.ura ,,nearestf)omt - zwraca adres tr'zech 3 punkty
najblizszych punktow wzgledem punktu pierwotnego

Przyktadowa odpowiedz:

<?xml version="1.0" encoding="utf-8"?>
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<soap:Envelope xmlins:soap="http://schemas.xmlsoap.org/soap/envelope/"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xmins:xsd="http://www.w3.0rg/2001/XMLSchema">
<soap:Body>
<GiveMeAllLocationWithAllDataWithZipCodeResponse xmins="https://91.242.220.103/WebServicePwR">
<GiveMeAllLocationWithAllDataWithZipCodeResult>
<xs:schema id="NewDataSet" xmIns="" xmlIns:xs="http://www.w3.0rg/2001/XMLSchema"
xmlins:msdata="urn:schemas-microsoft-com:xml-msdata">
<xs:element name="NewDataSet" msdata:lsDataSet="true" msdata:UseCurrentLocale="true">
<xs:complexType>
<xs:choice minOccurs="0" maxOccurs="unbounded">
<xs:element name="LocationWithAllData2">
<xs:complexType>
<xs:sequence>
<xs:element name="DestinationCode" type="xs:string" minOccurs="0" />
<xs:element name="StreetName" type="xs:string" minOccurs="0" />
<xs:element name="BuildingNumber" type="xs:string" minOccurs="0" />
<xs:element name="City" type="xs:string" minOccurs="0" />
<xs:element name="Zipcode" type="xs:string" minOccurs="0" />
<xs:element name="District" type="xs:string" minOccurs="0" />
<xs:element name="Longitude" type="xs:string" minOccurs="0" />
<xs:element name="Latitude" type="xs:string" minOccurs="0" />
<xs:element name="Province" type="xs:string" minOccurs="0" />
<xs:element name="CashOnDelivery" type="xs:boolean" minOccurs="0" />
<xs:element name="OpeningHours" type="xs:string" minOccurs="0" />
<xs:element name="Location" type="xs:string" minOccurs="0" />
<xs:element name="PSD" type="xs:string" minOccurs="0" />
<xs:element name="Available" type="xs:string" minOccurs="0" />
<xs:element name="0Obszar" type="xs:string" minOccurs="0" />
<xs:element name="Mikrorejon" type="xs:string" minOccurs="0" />
<xs:element name="Skrotnrpok" type="xs:string" minOccurs="0" />
<xs:element name="Sortownia" type="xs:string" minOccurs="0" />
<xs:element name="Presort" type="xs:string" minOccurs="0" />
<xs:element name="Czas" type="xs:string" minOccurs="0" />
<xs:element name="PointType" type="xs:string" minOccurs="0" />
<xs:element name="NearestPoints"
msdata:DataType="System.Collections.Generic.List 1[[Pwr.Common.Models.NearestPoint,
Pwr.Common.Models, Version=1.0.0.0, Culture=neutral, PublicKeyToken=null]], mscorlib, Version=4.0.0.0,
Culture=neutral, PublickeyToken=b77a5c561934e089" type="xs:anyType" minOccurs="0" />
</xs:sequence>
</xs:complexType>
</xs:element>
</xs:choice>
</xs:complexType>
</xs:element>
</xs:schema>
<diffgr:diffgram xmins:msdata="urn:schemas-microsoft-com:xml-msdata" xmins:diffgr="urn:schemas-
microsoft-com:xml-diffgram-v1">
<NewDataSet xmlns="">
<LocationWithAllData2 diffgr:id="LocationWithAllData218" msdata:rowOrder="17">
<DestinationCode>BD-125922-MM-02</DestinationCode>
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<StreetName>KOSCIUSZKI</StreetName>
<BuildingNumber>32</BuildingNumber>
<City>Kruszwica</City>
<Zipcode>88-150</Zipcode>
<District>Kruszwica</District>
<Longitude>18.33475</Longitude>
<lLatitude>52.67415</Latitude>
<Province>Kujawsko-Pomorskie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:00:00-24:00, S0:00:00-24:00, Nd:00:00-24:00</OpeningHours>
<Location>Automat paczkowy obok sklepu</Location>
<PSD>125922</PSD>
<Available>T</Available>
<Obszar />
<Mikrorejon>BDMM</Mikrorejon>
<Skrotnrpok>MM-02</Skrotnrpok>
<Sortownia />
<Presort>01</Presort>
<Czas>Sl</Czas>
<PointType>PKN</PointType>
<NearestPoints>
<NearestPoint>
<Name>Kruszwica Kos$ciuszki 32 </Name>
<Distance>29</Distance>
</NearestPoint>
</NearestPoints>
</LocationWithAllData2>

417 GIVEMEALLAPMLOCATION

Lista Automatycznych Maszyn Paczkowych APM w ramach ustugi ORLEN Paczka z rozszerzonym

opisem lokalizacji.

4171 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED) 10 char

Zwracane wartosci:

417.2 Odpowiedz

<DestinationCode> | Kod POPeR 15 char
<StreetName> Ulica, na ktérej miesci sie punkt odbioru paczek 50 char
<BuildingNumber> | Numer budynku, numer lokalu 15 char
<City> Miasto, gdzie miesci sie pop 40 char
<District> Dzielnica, gdzie miesci sie pop 30 char
<Zipcode> Kod pocztowy pop 6 char
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<Longitude> Dtugos¢ geograficzna pop 10 char
<Latitude> Szerokos¢ geograficzna pop 10 char
<Province> Wojewddztwo 20 char
<CashOnDelivery> | Czyjestustuga-poebraniewsa (rozdziat 3.12) (false) boolean
<OpeningHours> Informacja o godzinach otwarcia pop 50 char
<Location> Opis lokalizacji punktu odbioru paczek 255 char
<PSD> Nr PSD 6 char
<Available> Czy pop jest dostepny t/n 1 char
<PointType> Rodzaj punktu/automatu (automat - apm, stacja orlen — pkn) 3 char
Przyktad:

<AllApmLocation diffgr:id="AllApmLocation3" msdata:rowOrder="2">
<DestinationCode>LB-524373-20-13</DestinationCode>
<StreetName>LUBARTOWSKA</StreetName>
<BuildingNumber>12</BuildingNumber>

<City>Kamionka</City>

<District>Kamionka</District>

<Zipcode>21-132</Zipcode>

<Longitude>22.4643</Longitude>

<lLatitude>51.4695</Latitude>

<Province>Lubelskie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:08:00-17:00, S0:08:00-15:00, Nd: nieczynne</OpeningHours>
<Location>Automat paczkowy obok sklepu</Location>
<PSD>524373</PSD>

<Available>T</Available>

</AllApmLocation>

418 GIVEMEALLRUCHLOCATION

Lista wszystkich typéw punktéw (APM, PKN, PSD, PPP, PPK) w ramach ustugi ORLEN Paczka z
rozszerzonym opisem lokalizacji.

418.1 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED) 10 char

4.18.2 Odpowiedz

Zwracane wartosci:
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<DestinationCode>

Kod POPeR

15 char

Ulica, na ktérej miesci sie punkt

<StreetName> odbioru paczek 50 char
<BuildingNumber> Numer budynku, numer lokalu 15 char
<City> Miasto, gdzie miesci sie pop 40 char
<District> Dzielnica, gdzie miesci sie pop 30 char
<Latitude> Szerokosc¢ geograficzna pop 10 char
<Longitude> Dtugos¢ geograficzna pop 10 char
<Province> Wojewddztwo 20 char
e ran

<CashOnDelivery>

(rozdziat 3.12)

(false) boolean

Informacja o godzinach otwarcia

<OpeningHours> pop 50 char
Opis lokalizacji punktu odbioru
<Location> paczek 255 char
<PSD> Nr PSD 6 char
<Available> Czy pop jest dostepny t/n 1 char
Rodzaj punktu (wtasny - PSD,
partnerski — psp, ppp, psf, ppk,
<PointType> automat - apm, stacja orlen — pkn) | 3 char

Przyktad:

<DestinationCode>BD-105239-46-43</DestinationCode>
<StreetName>POZNANSKA</StreetName>
<BuildingNumber>5</BuildingNumber>

<City>Inowroctaw</City>

<District>Inowroctaw</District>
<Longitude>18.2615</Longitude>
<Latitude>52.7936</Latitude>
<Province>Kujawsko-Pomorskie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-18:00, S0:07:00-14:00, Nd: nieczynne</OpeningHours>
<Location>Automat paczkowy obok sklepu.</Location>

<PSD>105239</PSD>
<Available>T</Available>

<PointType>PSD</PointType>

419 GIVEMEALLRUCHZIPCODE

Lista wszystkich typéw punktéw (APM, PKN, PSD, PPP, PPK) w ramach ustugi ORLEN Paczka z
rozszerzonym opisem lokalizacji i informacjg o kodzie pocztowym.

Parametry wywotania:

419.1 Wywolanie

Identyfikator klienta nadany

<PartnerID> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
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Zwracane wartosci:

419.2 Odpowiedz

<CashOnDelivery>

(rozdziat 3.12)

<DestinationCode> Kod POPeR 15 char
Ulica, na ktérej miesci sie punkt
<StreetName> odbioru paczek 50 char
<BuildingNumber> Numer budynku, numer lokalu 15 char
<City> Miasto, gdzie miesci sie pop 40 char
<District> Dzielnica, gdzie miesci sie pop 30 char
<Latitude> Szerokos¢ geograficzna pop 10 char
<Longitude> Dtugos¢ geograficzna pop 10 char
<Province> Wojewddztwo 20 char
o brani

(false) boolean

Informacja o godzinach otwarcia

<OpeningHours> pop 50 char
Opis lokalizacji punktu odbioru
<Location> paczek 255 char
<PSD> Nr PSD 6 char
<Available> Czy pop jest dostepny t/n 1 char
<Zipcode> Kod pocztowy pop 6 char
Przyktad:

<DestinationCode>BD-105239-46-43</DestinationCode>
<StreetName>POZNANSKA</StreetName>
<BuildingNumber>5</BuildingNumber>
<City>Inowroctaw</City>
<District>Inowroctaw</District>
<Longitude>18.2615</Longitude>
<latitude>52.7936</Latitude>
<Province>Kujawsko-Pomorskie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-18:00, S0:07:00-14:00, Nd: nieczynne</OpeningHours>
<Location> Automat paczkowy obok sklepu</Location>
<PSD>105239</PSD>

<Available>T</Available>

<PointType>PSD</PointType>
<Zipcode>12-345</Zipcode>

420 GIVEMEALLRUCHWITHFILLED

Funkcjonalno$¢ wskazywania przepetnienia punktu odbioru zostata wytaczona.
Lista wszystkich typéw punktéw (APM, PKN, PSD, PPP, PPK) w ramach ustugi ORLEN Paczka z
rozszerzonym opisem lokalizacji oraz uwzglednieniem parametru przepetnienia. W przypadku

52 API_ORLENPaczka_v_1 26 002



przepetnionego punktu, zwracane jest do 5 punktéw alternatywnych znajdujacych sie w obrebie 1,5
km od przepetnionego punktu.

4.20.1 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED)10 char

Hasto klienta nadane przez
ORLEN Paczka

<PartnerKey> (REQUIRED)10 char

Przyktad z minimalng wymagana lista pdl:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>

4.20.2 Odpowiedz

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
<Data> Lista punktéw w ramach Ustugi ORLEN Paczka
Data struktura
<PointPwR> Dane punktu w ramach ustugi ORLEN Paczka
PointPwR struktura
<DestinationCode> Kod POPeR 15 char
Ulica, na ktdérej miesci sie punkt
<StreetName> odbioru paczek 50 char
<BuildingNumber> Numer budynku, numer lokalu 15 char
<City> Miasto, gdzie miesci sie pop 40 char
<District> Dzielnica, gdzie miesci sie pop 30 char
<Latitude> Szerokosc¢ geograficzna pop 10 char
<Longitude> Dtugos¢ geograficzna pop 10 char
<Province> Wojewddztwo 20 char
Cayjest-ustuga-pobraniowa (rozdziat
<CashOnDelivery> 3.12) (false) boolean
Informacja o godzinach otwarcia
<OpeningHours> pop 50 char
Opis lokalizacji punktu odbioru
<Location> paczek 255 char
<PSD> Nr PSD 6 char
Rodzaj punktu (wtasny - PSD,
partnerski — psp, ppp, psf, ppk,
<PointType> automat - apm, stacja orlen — pkn) 3 char
Stan przepetnienia punktu
<Filled> true/false boolean
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Lista zawierajgca do 5
sugerowanych punktéw
alternatywnych (dostepna w

<Suggestions xsi:nil="true" /> przypadku przepetnienia) (1...5)
<Available> Czy pop jest dostepny t/n 1 char
<ZipCode> Kod pocztowy pop 6 char

Suggestions struktura
Dane sugerowanego punktu alternatywnego w
<PointPwRSuggestion> ramach ustugi ORLEN Paczka

PointPwRSuggestion struktura

<DestinationCode> Kod POPeR 15 char
<PSD> Nr PSD 6 char
Odlegtos¢ od przepetnionego
<Distance> punktu wyrazona w km 6 char
Przykiad:

<Err>0</Err>

<ErrDes>0K</ErrDes>

<Data>

<PointPwR>

<DestinationCode>BD-106088-31-40</DestinationCode>
<StreetName>POWSTANCOW WIELKOPOLSKICH</StreetName>
<BuildingNumber>53</BuildingNumber>
<City>Bydgoszcz</City>
<District>Bydgoszcz</District>
<Latitude>53.1303</Latitude>
<Longitude>18.0389</Longitude>
<Province>Kujawsko-Pomorskie</Province>
<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-18:00, S0:07:00-14:00, Nd: nieczynne</OpeningHours>
<Location>Automat paczkowy obok sklepu</Location>
<PSD>106088</PSD>
<PointType>PSD</PointType>
<Filled>true</Filled>
<Suggestions>
<PointPwRSuggestion>
<DestinationCode>BD-185280-31-26</DestinationCode>
<PSD>185280</PSD>
<Distance>0.4815</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>
<DestinationCode>BD-268086-31-01</DestinationCode>
<PSD>268086</PSD>
<Distance>0.5564</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>
<DestinationCode>BD-785576-31-21</DestinationCode>
<PSD>785576</PSD>
<Distance>0.6301</Distance>
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</PointPwRSuggestion>
<PointPwRSuggestion>
<DestinationCode>BD-857086-31-41</DestinationCode>
<PSD>857086</PSD>
<Distance>0.7714</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>
<DestinationCode>BD-640946-31-30</DestinationCode>
<PSD>640946</PSD>
<Distance>1.0583</Distance>
</PointPwRSuggestion>
</Suggestions>
<Available>true</Available>
<ZipCode>03-236</ZipCode>
</PointPwR>
<PointPwR>

</PointPwR>

</Data>

4.21 GIVEMEALLRUCHWITHFILLEDD1

Funkcjonalno$¢ wskazywania przepetnienia punktu odbioru zostata wytaczona.

Lista wszystkich typéw punktéw (APM, PKN, PSD, PPP, PPK) w ramach ustugi ORLEN Paczka
spetniajgcych zatozenia dostawy w terminie D+1 z rozszerzonym opisem lokalizacji oraz
uwzglednieniem parametru przepetnienia. W przypadku przepetnionego punktu, zwracane jest do 5
punktow alternatywnych znajdujacych sie w obrebie 1,5 km od przepetnionego punktu.

4.21.1 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED)10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED)10 char

Przyktad z minimalng wymagana lista pal:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>

4.21.2 Odpowiedz

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
<Data> Lista punktow w ramach Ustugi ORLEN Paczka
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Data struktura

<PointPwR>

Dane punktu w ramach ustugi ORLEN Paczka

PointPwR struktura

<DestinationCode> Kod POPeR 15 char
Ulica, na ktdérej miesci sie punkt
<StreetName> odbioru paczek 50 char
<BuildingNumber> Numer budynku, numer lokalu 15 char
<City> Miasto, gdzie miesci si¢ pop 40 char
<District> Dzielnica, gdzie miesci sie pop 30 char
<Latitude> Szeroko$¢ geograficzna pop 10 char
<Longitude> Dtugosé geograficzna pop 10 char
<Province> Wojewddztwo 20 char
Czyjestustuga-pobraniewa (rozdziat
<CashOnDelivery> 3.12) (false) boolean

Informacja o godzinach otwarcia

<OpeningHours> pop 50 char
Opis lokalizacji punktu odbioru
<Location> paczek 255 char
<PSD> Nr PSD 6 char
Rodzaj punktu (wtasny - PSD,
partnerski — psp, ppp, psf, ppk,
<PointType> automat - apm, stacja orlen — pkn) 3 char
Stan przepetnienia punktu
<Filled> true/false boolean
Lista zawierajgcado 5
sugerowanych punktéw
alternatywnych (dostepna w
<Suggestions xsi:nil="true" /> przypadku przepetnienia) (1...5)
<Available> Czy pop jest dostepny t/n 1 char
<ZipCode> Kod pocztowy pop 6 char

Suggestions struktura

<PointPwRSuggestion>

Dane sugerowanego punktu alternatywnego w
ramach ustugi ORLEN Paczka

PointPwRSuggestion struktura

<DestinationCode> Kod POPeR 15 char
<PSD> Nr PSD 6 char
Odlegtos¢ od przepetnionego
<Distance> punktu wyrazona w km 6 char
Przyktad:

<Err>0</Err>

<ErrDes>0K</ErrDes>

<Data>

<PointPwR>

<DestinationCode>BD-106088-31-40</DestinationCode>
<StreetName>POWSTANCOW WIELKOPOLSKICH</StreetName>
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</Data>
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<BuildingNumber>53</BuildingNumber>
<City>Bydgoszcz</City>
<District>Bydgoszcz</District>
<Latitude>53.1303</Latitude>
<Longitude>18.0389</Longitude>
<Province>Kujawsko-Pomorskie</Province>
<CashOnDelivery>false</CashOnDelivery>

<OpeningHours>Pn-Pt:06:00-18:00, S0:07:00-14:00, Nd: nieczynne</OpeningHours>

<Location>Automat paczkowy obok sklepu</Location>
<PSD>106088</PSD>
<PointType>PSD</PointType>
<Filled>true</Filled>
<Suggestions>
<PointPwRSuggestion>

<DestinationCode>BD-185280-31-26</DestinationCode>

<PSD>185280</PSD>

<Distance>0.4815</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>

<DestinationCode>BD-268086-31-01</DestinationCode>

<PSD>268086</PSD>

<Distance>0.5564</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>

<DestinationCode>BD-785576-31-21</DestinationCode>

<PSD>785576</PSD>

<Distance>0.6301</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>

<DestinationCode>BD-857086-31-41</DestinationCode>

<PSD>857086</PSD>

<Distance>0.7714</Distance>
</PointPwRSuggestion>
<PointPwRSuggestion>

<DestinationCode>BD-640946-31-30</DestinationCode>

<PSD>640946</PSD>
<Distance>1.0583</Distance>
</PointPwRSuggestion>
</Suggestions>
<Available>true</Available>
<ZipCode>03-236</ZipCode>
</PointPwR>
<PointPwR>

</PointPwR>
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4.22 GIVEMEPSDZIPCODE

Metoda nieaktywna od 01.01.2025 ze wzgledu na zamkniecie punktéw PSD oraz wytgczenie ustugi

COD.

Lista Kioskdw w ramach ORLEN Paczka z rozszerzonym opisem lokalizacji.

Parametr wywotania:

4,221 Wywolanie

BRAK

Zwracane wartosci:

4.22.2 Odpowiedz

<CashOnDelivery>

(rozdziat 3.12)

<DestinationCode> Kod POPeR 15 char
Ulica, na ktdérej miesci sie Punkt
<StreetName> Odbioru Paczek 50 char
Numer budynku, gdzie miesci sie
<BuildingNumber> PoOP 15 char
<City> Miasto, gdzie miesci sie POP 40 char
<District> Dzielnica, gdzie miesci sie POP 30 char
<lLatitude> Szerokos¢ geograficzna POP 10 char
<Longitude> Dtugos¢ geograficzna POP 10 char
<Province> Wojewddztwo 20 char
T brani

(false) boolean

Informacja o godzinach otwarcia

<OpeningHours> POP 50 char
Opis lokalizacji Punktu Odbioru
<Location> Paczek 255 char
<PSD> Nr PSD 6 char
<Available> Dostepnos¢ punktu 1 char
<Zipcode> Kod pocztowy POP 6 char
Przyktad:

<DestinationCode>KL-895926-J1-62</DestinationCode>
<StreetName>MARSZAt KOWSKA</StreetName>
<BuildingNumber>82</BuildingNumber>

<City>Warszawa</City>

<District>Srodmiescie</District>
<Longitude>21.0137</Longitude>
<latitude>52.2274</Latitude>
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<Province>Mazowieckie</Province>

<CashOnDelivery>false</CashOnDelivery>
<OpeningHours>Pn-Pt:06:00-19:00, S0:06:00-15:00, Nd: nieczynne</OpeningHours>
<Location>Automat paczkowy obok sklepu</Location>

<PSD>895926</PSD>
<Available>T</Available>

<Zipcode> 00-517</Zipcode>

4.23 GIVEMEPACKSTATUS

Metoda zwracajgca aktualny status paczki w ramach ustugi ORLEN Paczka.

Metoda GiveMePackStatus zwraca statusy sledzenia nie starsze niz 90 dni. Statusy dodane do

przesytki ponad 90 dni przed datg zapytania API nie zostang zwrdcone.

Metoda zwraca ostatni status paczki wskazanej w zapytaniu API.

Nie zwraca ona statusdw dla paczek powigzanych z odpytywang paczka.

Czas zwracany w tagu <Data> jest w strefie UTC+1 (lokalny czas polski). Prosimy zignorowac znak “Z”

na koncu formatu czasu.

Parametry wywotania:

4.23.1 Wywotanie

<PartneriD>

Identyfikator klienta nadany
przez ORLEN Paczka

(REQUIRED)10 char

Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED)10 char
<PackCode> Numer kodu paczki zaawizowanej | 13 char

9 char — numer bez prefixu +48
<PhoneNumber> Numer telefonu odbiorcy 12 char — numer z prefixem +48

Zwracane wartosci:

4.23.2 Odpowiedz

<PackCode> Numer kodu paczki zaawizowanej | 13 char
<Trans> Status paczki 4 char
<Trans_Des> Opis statusu 40 char

<Data>

Data od kiedy paczka jest w
statusie

YYYY-MM-DDThh:mm:ssTZD

<Destination>

Kod POPeR

15 char

Przyktad:

<PackCode>2100123123123</PackCode>

<Trans>680</Trans>

<Trans_Des>W Transporcie do Kiosku</Trans_Des>
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<Data>2024-12-14T04:35:10.9237746Z</Data>
<Destination>KL-895926-J1-62</Destination>

4.24 GIVEMEPACKSTATUSLIST

Metoda zwracajgca aktualng liste statuséw paczek w ramach ustugi ORLEN Paczka.

Metoda GiveMePackStatusList zwraca statusy Sledzenia nie starsze niz 90 dni. Statusy dodane do
przesytki ponad 90 dni przed datg zapytania API nie zostang zwrdcone.

Maksymalna ilos¢ paczek zadeklarowanych w jednym wywotaniu to 1000.

Deklaracja paczki, dla ktérej majg zosta¢ zwrdcone statusy odbywa sie w tagu <string> obiektu
<PackCodes></PackCodes> (maksymalna ilo$¢ tagéw <string> to 1000).

Metoda zwraca aktualne statusy paczek, ktére zostaty wskazane w zapytaniu API.

Nie zwraca ona statuséw dla paczek powigzanych z odpytywanymi paczkami.

Czas zwracany w tagu <Data> jest w strefie UTC+1 (lokalny czas polski). Prosimy zignorowac znak “Z”
na koricu formatu czasu.

4.241 Wywolanie

Parametry wywotania:

<PackCodes> Lista numerdw paczek (REQUIRED) (ilo$¢ 1 ... 1000)
Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED)10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED)10 char

<PackCodes> struktura

<string> Numer Kodu Paczki | (REQUIRED)13 char

Przyktad z minimalng wymagana listg pol:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>
<PackCodes>
<string>2100123123123</string>
</PackCodes>

4.24.2 Odpowiedz

Zwracane wartosci:

<PackCode> Numer kodu paczki zaawizowanej | 13 char
<Trans> Status paczki 4 char
<Trans_Des> Opis statusu 40 char
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Data od kiedy paczka jest w
<Data> statusie YYYY-MM-DDThh:mm:ssTZD
<Destination> Kod POPeR 15 char
Przyktad:

<PackCode>2100123123123</PackCode>
<Trans>200</Trans>

<Trans_Des>Zaawizowana do PwR</Trans_Des>
<Data>2024-10-22T13:18:49.9237746Z</Data>
<Destination>WS-324889-U6-02</Destination>

4.25 GIVEMEPACKSTATUSFULLHISTORY

Metoda pozwalajgca pobrac petng historie paczki.

Metoda GiveMePackStatusFullHistory zwraca statusy Sledzenia nie starsze niz 90 dni. Statusy dodane
do przesytki ponad 90 dni przed datg zapytania APl nie zostang zwrdcone.

Metoda zwraca petng historie paczki, ktéra zostata wskazana w zapytaniu API.

Zwraca takze statusy powigzanych przesytek zwrotu operacyjnego.

Nie zwraca statuséw powigzanych przesytek zwrotu konsumenckiego.

Czas zwracany w tagu <Data> jest w strefie UTC+1 (lokalny czas polski). Prosimy zignorowac znak “Z”
na koncu formatu czasu.

4.251 Wywolanie

Parametry wywotania:

<PackCode> Numer kodu paczki (REQUIRED)13 char
Identyfikator Klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED)10 char
Hasto Klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED)10 char

Przyktad z minimalng wymagana listg pdl:

<PackCode>2100123123123</PackCode>
<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>

4.25.2 Odpowiedz

Zwracane wartosci:

<PackCode> Numer kodu paczki zaawizowanej 13 char
<Trans> Status paczki 4 char
<Trans_Des> Opis statusu 40 char
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<Data>

Data od kiedy paczka jest w
statusie

YYYY-MM-DDThh:mm:ssTZD

<Destination>

Kod POPeR

15 char

<Cl_From>

Nr centrum logistycznego, na
obszarze, ktorego przesytka zostata
nadana

4 char

<Cl_From_Des>

Cl, na obszarze ktorego przesytka
zostata nadana

9 char

<Cl>

Cl, na obszar ktérego przesytka
zostata zaawizowana

9 char

<Cl_Des>

Nr cl, na obszar ktorego przesytka
zostata zaawizowana

4 char

<Attribute>

Atrybut przesytki (mobilny — punkt
mobilny, alternatywny — punkt
alternatywny, zmieniony — punkt
zmieniony, powrot — powroét
przesytki do punktu nadania,
2_powrot — powrdt przesytki do
magazynu nadania, zwrot — paczka
zwrotna do magazynu nadawcy)

12 char

<StreetName>

Ulica, na ktdérej miesci sie punkt
odbioru paczek

50 char

<City>

Miasto, gdzie miesci sie pop

40 char

<OpeningHours>

Informacja o godzinach otwarcia
pop

50 char

<Location>

Opis lokalizacji punktu odbioru
paczek

255 char

Przyktad:

<PackCode>2100123123123</PackCode>
<Trans>200</Trans>

<Trans_Des>Zaawizowana do PwR</Trans_Des>
<Data>2024-10-22T13:18:49.8306261Z</Data>
<Destination>WS-324889-U6-02</Destination>
<Cl_From>0000</Cl_From>
<Cl_From_Des>SC</Cl_From_Des>

<CI>0130</CI>

<Cl_Des>WARSZAWA</Cl_Des>

<Attribute />

<StreetName>NOWY SWIAT 6/12</StreetName>
<City>Warszawa</City>
<OpeningHours>Pn-Pt:06:15-16:00, So: nieczynne, Nd: nieczynne</OpeningHours>
<Location> Automat paczkowy obok sklepu </Location>
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4.26 GIVEMEPACKSTATUSFULLHISTORYLIST

Metoda zwracajgaca historie statuséw paczki w ramach listy paczek.

Metoda GiveMePackStatusFullHistoryList zwraca statusy $ledzenia nie starsze niz 90 dni. Statusy
dodane do przesytki ponad 90 dni przed datg zapytania API nie zostang zwrécone.

Maksymalna ilos¢ paczek zadeklarowanych w jednym wywotaniu to 1000.

Deklaracja paczki, dla ktérej majg zostaé zwrdcone statusy odbywa sie w tagu <string> obiektu
<PackCodes></PackCodes> (maksymalna ilo$¢ tagéw <string> to 1000).

Metoda zwraca petna historie paczki, ktéra zostata wskazana w zapytaniu API.

Nie zwraca ona statuséw dla paczek powigzanych z odpytywang paczka.

Czas zwracany w tagu <Data> jest w strefie UTC+1 (lokalny czas polski). Prosimy zignorowac¢ znak “Z”
na koncu formatu czasu.

4.26.1 Wywolanie

Parametry wywotania:

<PackCodes> Lista numerdéw paczek (ean 13) (REQUIRED) (ilos¢ 1...1000)
Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED) 10 char

Przyktad z minimalng wymagana lista pol:

<PackCodes>
<string>3400012345678</string>
</PackCodes>
<PartnerlD>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>

4.26.2 Odpowiedz

<PackCode> Numer kodu paczki zaawizowanej | 13 char
<Trans> Status paczki 4 char
<Trans_Des> Opis statusu 40 char
Data od kiedy paczka jest w
<Data> statusie YYYY-MM-DDThh:mm:ssTZD
<Destination> Kod POPeR 15 char

Nr centrum logistycznego, na
obszarze, ktorego przesytka
<Cl_From> zostata nadana 4 char

Cl, na obszarze ktorego przesytka

<Cl_From_Des> zostata nadana 9 char
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Cl, na obszar ktorego przesytka
<CI> zostata zaawizowana 9 char

Nr cl, na obszar ktérego przesytka
<Cl_Des> zostata zaawizowana 4 char

Atrybut przesytki (mobilny —
punkt mobilny, alternatywny —
punkt alternatywny, zmieniony —
punkt zmieniony, powrot —
powrdt przesytki do punktu
nadania, 2_powrot — powrot
przesytki do magazynu nadania,
zwrot — paczka zwrotna do

<Attribute> magazynu nadawcy) 12 char
Ulica, na ktérej miesci sie punkt

<StreetName> odbioru paczek 50 char

<City> Miasto, gdzie miesci sie pop 40 char
Informacja o godzinach otwarcia

<OpeningHours> pop 50 char
Opis lokalizacji punktu odbioru

<Location> paczek 255 char

Przyktad:

<PackCode>2100123123123</PackCode>
<Trans>200</Trans>

<Trans_Des> Zaawizowana do PwWR </Trans_Des>
<Data>2018-01-15T12:00:00.9237746Z</Data>
<Destination>PZ-730614-04-38</Destination>
<Cl_From>0000</Cl_From>
<Cl_From_Des>SC</Cl_From_Des>

<Cl>6306</CI>

<Cl_Des>POZNAN</C|_Des>

<Attribute />

<StreetName>Jasielska 11</StreetName>
<City>Poznan</City>
<OpeningHours>Pn-Pt:06:00-16:00, So: nieczynne, Nd: nieczynne</OpeningHours>
<Location>Automat paczkowy obok sklepu</Location>

4.27 GIVEPARTNERSTATUS

Metoda stuzy do pobrania informacji o kliencie ORLEN Paczka.

4.27.1 Wywolanie
Parametry wywotania:

Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED)10 char
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<PartnerKey>

Hasto klienta nadane przez
ORLEN Paczka

(REQUIRED)10 char

Zwracane wartosci:

4.27.2 Odpowiedz

<Err> Numer btedu
<ErrDes> Opis btedu
<PaymentType> Typ ptatnosci (postpaid lub prepaid)

<CashOnDelivery>

Pobranie (false) (rozdziat 3.12)

<Insurance>

Ubezpieczenie (true/false)

<DeliveryRUCH>

Odbidr paczek (true/false)

<PackPrice>

Cena za przesytke (w groszach)

<CODProvision>

Prowizja za pobranie (w procentach)

<CODMinPrice>

Minimalna prowizja za pobranie (w groszach)

<FirstName> Imig
<LastName> Nazwisko
<CompanyName> Firma
<StreetName> Ulica
<BuildingNumber> Numer budynku
<PostCode> Kod pocztowy
<City> Miasto

<Nip> Nip
<PhoneNumber> Numer telefonu
<EMail> Adres email

<InsPrice100>

Prowizja za ubezpieczenie do 100 pln (w groszach)

<InsPrice300>

Prowizja za ubezpieczenie do 300 pln (w groszach

<InsPrice500>

Prowizja za ubezpieczenie do 500 pln (w groszach

<InsPrice1000>

Prowizja za ubezpieczenie do 1000 pln (w groszach)

<InsPrice1500>

Prowizja za ubezpieczenie do 1500 pln (w groszach)

<InsPrice2000>

Prowizja za ubezpieczenie do 2000 pln (w groszach)

<InsPrice2500>

Prowizja za ubezpieczenie do 2500 pln (w groszach)

<InsPrice5000>

Prowizja za ubezpieczenie do 5000 pln (w groszach)

Przyktad:
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<Err>000</Err>

<ErrDes>saved</ErrDes>
<PaymentType>POSTPAID</PaymentType>
<CashOnDelivery>false</CashOnDelivery>
<Insurance >false</Insurance>
<DeliveryRUCH >true</DeliveryRUCH>
<PackPrice>850</PackPrice>
<CODProvision>0.95</CODProvision>
<CODMIinPrice>150</CODMinPrice>
<FirstName>Jan</FirstName>
<LastName>Nowak</LastName>
<CompanyName>Firma SA</CompanyName>
<StreetName>Prosta</StreetName>
<BuildingNumber>1234</BuildingNumber>
<PostCode>99-999</PostCode>
<City>Warszawa</City>
<Nip>123-456-78-90</Nip>
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<PhoneNumber>123456789</PhoneNumber>
<EMail>test@tt.pl</EMail>
<InsPrice100>0</InsPrice100>
<InsPrice200>0</InsPrice200>
<InsPrice300>0</InsPrice300>
<InsPrice500>100</InsPrice500>
<InsPrice1000>100</InsPrice1000>
<InsPrice1500>100</InsPrice1500>
<InsPrice2000>200</InsPrice2000>
<InsPrice2500>200</InsPrice2500>
<InsPrice5000>400</InsPrice5000>

4.28 GIVEPAYMENTTYPE

Metoda stuzy do pobrania typu ptatnosci klienta ORLEN Paczka.

4.28.1 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED)10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED)10 char

4.28.2 Odpowiedz

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
<PaymentType> Typ ptatnosci (postpaid lub prepaid)
Przyktad:
<Err>000</Err>

<ErrDes>saved</ErrDes>
<PaymentType>POSTPAID</PaymentType>

4.29 GIVESHIPPINGCODESTATUS

Metoda umozliwiajgca sprawdzenie czy podany kod nadania jest juz wykorzystany.
Kod nadania generowany jest za posrednictwem metody GenerateShippingCode (rozdziat 4.10).

4.29.1 Wywolanie
Parametry wywotania:
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Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED)10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED)10 char
Lista kodéw nadania do

<Codes> sprawdzenia (REQUIRED) (ilo$¢ 1...n)

<Codes> struktura

<string> | string

Przyktad z minimalng wymagana lista pal:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>
<Codes>

<string>0431523</string>
<string>0256356</string>

</Codes>

4.29.2 Odpowiedz

Zwracane wartosci:

<ShippingCode> Kod nadania
Kod paczki powigzanej z kodem nadania (jesli kod
<PackCode> uzyty)
<CodeStatus> Status kodu nadania
Przyktad:

<GiveShippingCodeStatus diffgr:id="GiveShippingCodeStatus1" msdata:rowOrder="0">
<ShippingCode>431512</ShippingCode>
<CodeStatus>wrong PartnerlD</CodeStatus>

</GiveShippingCodeStatus>

<GiveShippingCodeStatus diffgr:id="GiveShippingCodeStatus2" msdata:rowOrder="1">
<ShippingCode>256334</ShippingCode>
<PackCode>2100123123123</PackCode>
<CodeStatus>code used</CodeStatus>

</GiveShippingCodeStatus>

4.30 LABELPRINTDUPLICATE

Metoda stuzgca do ponownego pobrania etykiety zaawizowanej paczki. Etykieta zwracana jest w
formacie PDF.

4.30.1 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED)10 char
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Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED)10 char

<PackCode> Numer kodu paczki zaawizowanej | (REQUIRED) 13 char

Przyktad z minimalng wymagana lista pol:
<PartnerID>1234567890</PartnerID>

<PartnerKey>abcdefghijk</PartnerKey>
<PackCode>2100123123123</PackCode>

4.30.2 Odpowiedz

Etykieta w formacie PDF zwracana jest w tagu <Label>.

Zwracane wartosci:

<Err> Numer btedu

Opis btedu
211 - "lack of routing data for this label"
212 - "no permission to this label number"

<ErrDes> 213 - "parcel with this number already sent via RUCH"
<Label> Dokument PDF szyfrowany BASE64 (jesli err=0)
Przyktad:
<Err>213</Err>

<ErrDes> Parcel with this number already sent via RUCH</ErrDes>
<Label>null</Label>

4.31 LABELPRINTDUPLICATETWO

Metoda stuzgca do ponownego pobrania etykiety zaawizowanej paczki. Etykieta zwracana jest w
formacie PDF, PDF10, EPL, ZPL.

4.31.1 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<Format> Format etykiety (pdf, pdf10, epl (REQUIRED) 5 char
lub zpl)
Numer kodu paczki
<PackCode> zaawizowanej (REQUIRED) (13 char)

Przyktad z minimalng wymagana listg pdl:
<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>
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<PackCode>2100123123123</PackCode>

<Format>PDF</Format>

4.31.2 Odpowiedz

Etykieta zwracana jest w tagu <Label>.

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
211 - "Lack of routing data for this label"
212 - "No permission to this label number"
213 - "Parcel with this number already sent via
RUCH"
<Label> Etykieta w formacie PDF, PDF10, EPL, ZPL
szyfrowana BASE64 (jesli err=0)
Przykiad:
<Err>213</Err>

<ErrDes> Parcel with this number already sent via RUCH</ErrDes>

<lLabel>null</Label>

4.32 LABELPRINTDUPLICATELIST

Metoda stuzgca do ponownego pobrania listy zaawizowanych paczek.

Etykieta zwracana jest w formacie PDF, PDF10, EPL.

Maksymalna ilo$¢ jednorazowo zwrdconych etykiet wynosi 50.

Deklaracja paczki, dla ktérej ma zosta¢ wygenerowany duplikat odbywa sie w tagu <string> obiektu
<PackCodelist></PackCodeList> (maksymalna ilo$¢ tagdw <string> to 50).

Parametry wywotania:

4.32.1 Wywolanie

Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<Format> Format etykiety (pdf,pdf10 lub (REQUIRED) 3 char
epl)
<PackCodelList> Lista paczek (REQUIRED) (ilo$¢ 1...50)
<PackCodelist> struktura
<PackCode> | Numer kodu paczki | (REQUIRED)13 char

Przyktad z minimalng wymagana listg pél:
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<PartnerlD>1234567890</PartnerlD>
<PartnerKey>abcdefghijk</PartnerKey>
<Format>PDF</Format>
<PackCodelist>
<string>2100123123123</string>
</PackCodelList>

4.32.2 Odpowiedz
Etykieta zwracana jest w tagu <Label>.

Zwracane wartosci:

< PackCodelist > - lista paczek (1 ... n)

<Err> Numer btedu

<ErrDes> Opis btedu
211 - "Lack of routing data for this label"
212 - "No permission to this label number"
213 - "Parcel with this number already sent via
RUCH"
<Label> Etykieta w formacie PDF, PDF10, EPL szyfrowana
BASE64 (jesli err=0)

Przyktad:

<Err>000</Err>
<ErrDes>saved</ErrDes>
<lLabelData>base64</LabelData>

4.33 LABELPRINTDUPLICATELISTTWO

Metoda stuzgca do ponownego pobrania listy zaawizowanych paczek.

Etykieta zwracana jest w formacie PDF, PDF10, EPL, ZPL.

Maksymalna ilo$¢ jednorazowo zwrdconych etykiet wynosi 50.

Deklaracja paczki, dla ktérej ma zosta¢ wygenerowany duplikat odbywa sie w tagu <string> obiektu
<PackCodelist></PackCodeList> (maksymalna ilo$¢ tagdw <string> to 50).

4.33.1 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany
<PartnerlD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<Format> Format etykiety (pdf, pdf10, epl (REQUIRED) 5 char
lub zpl)
<PackCodelList> Lista paczek (REQUIRED) (ilo$¢ 1...50)
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<PackCodelist> struktura

<string> | Numer kodu paczki | (REQUIRED) 13 char

Przyktad z minimalng wymagana lista pal:

<PartnerlD>1234567890</Partner|D>
<PartnerKey>abcdefghijk</PartnerKey>
<Format>PDF</Format>
<PackCodelist>
<string>2100123123123</string>
</PackCodelList>

4.33.2 Odpowiedz

Etykieta zwracana jest w tagu <Label>.
Zwracane wartosci:

<PackCodelist> - lista paczek (1 ... 50)

<Err> Numer btedu
<ErrDes> Opis btedu
211 - "Lack of routing data for this label"
212 - "No permission to this label number"
213 - "Parcel with this number already sent via
RUCH"
<Label> Etykieta w formacie PDF, PDF10, EPL, ZPL
szyfrowana BASE64 (jesli err=0)

Przykiad:
<Err>000</Err>
<ErrDes>saved</ErrDes>
<LabelData>base64</LabelData>

4.34 PUTCUSTOMERPACK

Metoda stuzgca do awizowania przesytki ORLEN Paczka z pobranej puli numeréw wygenerowanych
za posrednictwem metody GenerateNumberWaybills (rozdziat 4.8).

Dane awizacyjne przekazane mogg byc¢ tylko raz dla danego numeru zarezerwowanej paczki. Podczas
préby przestania danych awizacyjnych dla paczki, ktéra juz je posiada zostanie zwrdcony btad ,,209 -
incorrect PackCode”.

4.341 Wywolanie

Parametry wywotania:

<PackCode> Numer kodu paczki (REQUIRED)13 char
Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED)10 char
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Hasto klienta nadane przez

<AmountCashOnDelivery>

(rozdziat 3.12)

<PartnerKey> ORLEN Paczka (REQUIRED)10 char
<DestinationCode> Kod POPeR (REQUIRED)15 char
<AlternativeDestinationCode> Alternatywny kod POPeR 15 char
<ReturnDestinationCode> Kod POPeR do zwrotu 15 char
<BoxSize> Wielkos¢ paczki (REQUIRED) 1 char
<PackValue> Wartos¢ przesytki (w groszach) 6 char
Raczkaza-pebraniem (rozdziat
<CashOnDelivery> 3.12)
kwota-pobrania{w-groszach}

<Insurance>

Ubezpieczenie paczki

(true/false) boolean

<EMail> Adres email odbiorcy 60 char
<FirstName> Imie odbiorcy 30 char
<LastName> Nazwisko odbiorcy 30 char
<CompanyName> Firma odbiorcy 70 char
<StreetName> Ulica z adresu odbiorcy 30 char
Numer budynku z adresu
<BuildingNumber> odbiorcy 10 char
Numer mieszkania z adresu
<FlatNumber> odbiorcy 10 char
<City> Miasto z adresu odbiorcy 30 char
<PostCode> Kod pocztowy z adresu odbiorcy 6 char
(REQUIRED)
9 char — numer bez prefixu +48
<PhoneNumber> Numer telefonu odbiorcy 12 char — numer z prefixem +48

<SenderEMail>

Adres email nadawcy

(REQUIRED) 60 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> Firma nadawcy 70 char
<SenderStreetName> Ulica z adresu nadawcy (REQUIRED)30 char

Numer budynku z adresu

<SenderBuildingNumber> nadawcy (REQUIRED)10 char
Numer mieszkania z adresu
<SenderFlatNumber> nadawcy 10 char

<SenderCity> Miasto z adresu nadawcy (REQUIRED) 30 char
<SenderPostCode> Kod pocztowy z adresu nadawcy | (REQUIRED) 6 char

(REQUIRED)

9 char — numer bez prefixu +48
<SenderPhoneNumber> Numer telefonu nadawcy 12 char — numer z prefixem +48
<SenderOrders> Dane referencyjne 30 char
<ReturnEMail> Adres email do zwrotu 60 char
<ReturnFirstName> Imie osoby do zwrotu 30 char
<ReturnLastName> - Nazwisko osoby do zwrotu 30 char
<ReturnCompanyName> Nazwa firm do zwrotu 70 char
<ReturnStreetName> Ulica z adresu do zwrotu 30 char

Numer budynku z adresu do
<ReturnBuildingNumber> zwrotu 10 char

Numer mieszkania z adresu do
<ReturnFlatNumber> zwrotu 10 char
<ReturnCity> Miasto z adresu do zwrotu 30 char
<ReturnPostCode> Kod pocztowy z adresu do zwrotu | 6 char

9 char — numer bez prefixu +48
<ReturnPhoneNumber> Numer telefonu do zwrotu 12 char — numer z prefixem +48
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Wybdr adresu do wydruku przy

zwrocie (1- adres nadania, 2 -
<PrintAdress> adres zwrotu) (REQUIRED) 1 char
<ReturnPack> Paczka zwrotna (t -jesli zwrotna) 1 char

Tytut przelewu dla paczki za
<TransferDescription> pobraniem 70 char

Mozliwos¢ nadania paczki
<ReturnAvailable> zwrotnej (t -jesli tak) 1 char
<ReturnQuantity> Liczba paczek zwrotnych 1 char

TransferDescription nie moze zawiera¢ znakow specjalnych.

Pola <FirstName> i <LastName> sg obowigzkowe, jesli nie podano wartos¢ w polu <CompanyName>.

Pola <SenderFirstName> i <SenderLastName> sg obowigzkowe, jesli nie podano wartos¢ w polu

<SenderCompanyName>.

Pole < ReturnDestinationCode> wypetniane jest tyko w przypadku: nadania w PSD i wyborze innego

PSD do zwrotu niz PSD w ktérym paczka zostanie nadana.

Przy wyborze punktu odbioru APM oraz PKN, pole <BoxSize> jest obowigzkowe i przyjmuje wartosci: S,

M lub L. W przeciwnym razie dla paczki zostanie przypisany rozmiar M.

Przyktad z minimalng wymagana lista pal:

<PackCode >2100123123123</PackCode>
<PartnerlD>1234567890</PartnerlD>
<PartnerKey>abcdefghijk</PartnerKey>
<DestinationCode>XX-142450-00-00</DestinationCode>

<FirstName>Jan</FirstName>

<LastName>Nowak</LastName>
<PhoneNumber>123456789</PhoneNumber>
<SenderEMail>test@tt.pl</SenderEMail>
<SenderCompanyName>Firma SA</SenderCompanyName>

<SenderStreetName>Prosta</SenderStreetName>

<SenderBuildingNumber>1234</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>99-999</SenderPostCode>
<SenderPhoneNumber>123456789</SenderPhoneNumber>

<PrintAdress>1</PrintAdress>

Zwracane wartosci:

4.34.2 Odpowiedz

<Err>

Numer btedu

<ErrDes>

Opis btedu

<PackCode_RUCH>

Numer ean-13 przesytki

<DestinationCode>

Kod POPeR (potwierdzenie lub zmiana)

<Destinationld>

Kod PSD

<PackPrice>

Cena przesytki (w groszach)
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| <PackPaid>

Optacenie przesytki true/false

Przyktad:

<Err>000</Err>
<ErrDes>saved</ErrDes>

<PackCode_RUCH>2100123123123</PackCode_RUCH>
<DestinationCode>XX-142450-00-00</ DestinationCode>
<Destinationld>142450</ Destinationld>

<PackPrice>745</PackPrice>
<PackPaid>false</ PackPaid>

4.35 PUTCUSTOMERPACKCANCELED

Metoda stuzy do anulowania paczek wczesniej zaawizowanych do ustugi ORLEN Paczka.

Parametry wywotania:

4.35.1 Wywolanie

Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez

<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
Numer kodu paczki

<PackCode> zaawizowanej (REQUIRED) 13 char

Zwracane wartosci:

4.35.2 Odpowiedz

<Err>

Numer btedu

<ErrDes>

Opis btedu

<PackCode>

Numer kodu paczki anulowane

Przyktad:

<Err>000</Err>
<ErrDes>saved</ErrDes>

<PackCode>2100123123123</PackCode>

4.36 PING

Metoda stuzy do sprawdzenia stanu potgczenia z webservice’m API.

Parametry wywotania:

4.36.1 Wywolanie

BRAK
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4.36.2 Odpowiedz

Zwracane wartosci:

<PingResult> ‘ Status potaczenia (true/false)

4.37 CALLPICKUP

Metoda stuzy do zamédwienia podjazdu kuriera w celu odebrania paczek. Adres przyjazdu
automatycznie pobierany jest z danych przypisanych do umowy klienta w systemie ORLEN Paczka.
W wywotaniu nalezy zadeklarowaé parametry <readyDate>, <pickupDate> okreslajgce przedziat
godzinowy przyjazdu kuriera. Dostepne przedziaty godzinowe przyjazdu kuriera zwracana sg w
odpowiedzi metody GetAvailablePickups (rozdziat 4.39).

Po wywotaniu tej metody w odpowiedzi zwracany jest numer zamdwienia podjazdu kuriera.
Anulowanie podjazdu kuriera mozliwe jest poprzez kontakt z opiekunem handlowym lub z infolinig
ORLEN Paczka podajgc numer zamodwienia kuriera.

Tagi <ReadyDate>, <PickupDate> oczekujg czasu podanego w strefie UTC+1 (lokalny czas polski).

4,371 Wywolanie

Parametry wywotania:

Identyfikator Klienta nadany

<partnerlD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto Klienta nadane przez

<partnerKey> ORLEN Paczka (REQUIRED) 10 char
Lista numerow paczek

<packList> przeznaczonych do odbioru (REQUIRED) (ilo$¢ 1...n) List<string>
Data i godzina poczatku

<readyDate> gotowosci paczki do podjecia (REQUIRED) YYYY-MM-DDThh:mm:ss
Data i godzina korica gotowosci

<pickupDate> paczki do podjecia (REQUIRED) YYYY-MM-DDThh:mm:ss

Przyktad:

<partnerld>1234567890</partnerld>
<partnerKey>abcdefghijk</partnerKey>
<packList>
<string>2100123123123</string>
<string>2100123123124</string>
</packList>
<readyDate>2025-11-26T11:00:00</readyDate>
<pickupDate>2025-11-26T13:00:00</pickupDate>
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Zwracane wartosci:

4.37.2 Odpowiedz

<Err> Numer btedu
<ErrDes> Opis btedu
<Data> Numer kodu zlecenia
Przyktad:
<Err>000</Err>

<ErrDes>Success</ErrDes>
<Data>13835004</Data>

4.38 CALLPICKUPNEW

Metoda stuzy do zaméwienia podjazdu kuriera w celu odebrania paczek na wskazany adres

zadeklarowany podczas wywotywania metody. W wywotaniu nalezy zadeklarowaé parametry

<readyDate>, <pickupDate> okreslajgce przedziat godzinowy przyjazdu kuriera. Dostepne przedziaty

godzinowe przyjazdu kuriera zwracana sg w odpowiedzi metody GetAvailablePickups (rozdziat 4.39).

Po wywotaniu tej metody w odpowiedzi zwracany jest numer zamodwienia podjazdu kuriera.

Anulowanie podjazdu kuriera mozliwe jest poprzez kontakt z opiekunem handlowym lub z infolinig

ORLEN Paczka podajgc numer zamodwienia kuriera.

Tagi <ReadyDate>, <PickupDate> oczekujg czasu podanego w strefie UTC+1 (lokalny czas polski).

4.38.1 Wywolanie

Parametry wywotania:

<PartneriD>

Identyfikator klienta nadany przez ORLEN Paczka

(REQUIRED) 10 char

Data i godzina poczatku gotowosci paczki do podjecia

<PartnerKey> Hasto klienta nadane przez ORLEN Paczka (REQUIRED) 10 char
<PackList> Lista numeréw paczek przeznaczonych do odbioru (REQUIRED) (ilos¢ 1...n) List<string>
<ReadyDate>

(REQUIRED) YYYY-MM-DDThh:mm:ss

<PickupDate>

Data i godzina konca gotowosci paczki do podjecia

(REQUIRED) YYYY-MM-DDThh:mm:ss

<PostCode> Kod pocztowy (REQUIRED) 6 char

<City> Miasto (REQUIRED) 30 char
<Street> Ulica (REQUIRED) 30 char
<BuildingNo> Numer budynku 10 char

<Email> Adres e-mail (REQUIRED) 60 char
<PartnerName> Nazwa firmy nadawcy (REQUIRED) 30 char
<PersonName> Imie klienta 30 char
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<PersonSurname>

Nazwisko klienta 30 char

<Telephone>

Numer telefonu klienta 9 char

jesli PickupDate ma domysing wartosé ("0001-01-01 00:00"), zwracany jest btagd z kodem
1052 (=MaxPickupDate is required);

jesli PickupDate jest ustawiony na niedziele, zwracany jest btagd 1054 (=MaxPickupDate
cannot be set to Sunday);

jesli ReadyDate ma domysing wartos¢ ("0001-01-01 00:00"), zwracany jest btagd z kodem
1053 (=Wartosc¢ ReadyDate nie zostata ustawiona);

jesli ReadyDate podamy jako wczesniejszg godzine niz czas obecny, ustawiany jest obecny
czas gotowosci do podjazdu;

jesli ReadyDate jest wieksze lub réwne (pdzniejsze lub réwne) niz PickupDate, zwracany jest
btad 1055 (=MaxPickupDate HOUR cannot be smaller than ReadyDate HOUR).

jesli wskazany kod pocztowy nie istnieje lub istnieje, ale godzina podjazdu (parametr
MaxPickupDate) dla wyniku wywotania metody GetAvailablePickups wynosi 01:00:00,
zostanie zwrécony bfad 400: Bad Request uniemozliwiajgcy zamdwienie podjazdu dla tego
kodu pocztowego. Dla takich kodéw pocztowych nie s3 realizowane podjazdy w ustudze
ORLEN Paczka;

jesli kod pocztowy, na ktéry nastepuje proba zamdwienia podjazdu znajduje sie w strefie C,
podjazd nie bedzie mozliwy oraz zostanie zwrdcony komunikat btedu 401 (=This Postal Code
does not have Pickup service enabled).

Przyktadowe wywotanie:

<Partnerld>1234567890</Partnerld>
<PartnerKey>abcdefghijk</PartnerKey>
<PackList>

<string>2100000000001</string>

<string>2100000000002</string>
</PackList>
<ReadyDate>2024-10-28T11:00:00</ReadyDate>
<PickupDate>2024-10-28T13:00:00</PickupDate>
<PostCode>03-236</PostCode>
<City>Warszawa</City>
<Street>Annopol</Street>
<BuildingNo>17A</BuildingNo>
<Email>test@klient.pl</Email>
<PartnerName>Firma Testowa</PartnerName>
<PersonName>Jan</PersonName>
<PersonSurname>Testowy</PersonSurname>
<Telephone>123456789</Telephone>

4.38.2 Odpowiedz

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
<Data> Numer kodu zlecenia
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Przyktadowa odpowiedz:
<CallPickupNewResult>

<Err>0</Err>
<ErrDes>Success</ErrDes>
<Data>12345678</Data>

</CallPickupNewResult>

4.39 GETAVAILABLEPICKUPS

Metoda stuzy do pobrania listy najblizszych dostepnych dat i godzin podjazdéw dla wskazanej

lokalizacji.

W przypadku wskazania nieistniejgcego kodu pocztowego, zostanie zwrdcony btgd 1048 -

»PickupLocation post code is invalid”.
W przypadku wskazania kodu pocztowego dla ktérego podjazd kuriera jest niedostepny
zostanie zwrdcony btad 401 — ,,Postal Code not available, check input”.

Czas zwracany w tagach <MinReadyDate>, <MaxPickupDate> jest w strefie UTC+1 (lokalny czas

polski).

Parametry wywotania:

4.39.1 Wywolanie

<PartneriD>

Identyfikator klienta nadany przez ORLEN Paczka

(REQUIRED) 10 char

<PartnerKey> Hasto klienta nadane przez ORLEN Paczka (REQUIRED) 10 char
<PostCode> Kod pocztowy (REQUIRED) 6 char
<City> Miasto 30 char

<Street> Ulica 30 char
<BuildingNo> Numer budynku 10 char

<Email> Adres e-mail 60 char
<PartnerName> Nazwa firmy nadawcy 30 char
<PersonName> Imie klienta 30 char
<PersonSurname> Nazwisko klienta 30 char
<Telephone> Numer telefonu klienta 9 char

Przyktadowe wywotanie:

<Partnerld>1234567890</Partnerld>
<PartnerKey>abcdefghijk</PartnerKey>
<PostCode>03-236</PostCode>

Zwracane wartosci:
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<Data> dostepne podjazdy AvailablePickupDay[]

<AvailablePickupDay> struktura

<Date> Dzien podjazdu
<MinReadyDate> Data i godzina poczatku gotowosci odbioru paczki
<MaxPickupDate> Data i godzina korica gotowosci odbioru paczki

Minimalny interwat miedzy zadeklarowanym minreadydate, a
<Minimumlnterval> maxpickupdate
<Err> Numer btedu
<ErrDes> Opis btedu

Przyktadowa odpowiedzi:

<GetAvailablePickupsResult>

<Err>0</Err>

<ErrDes>Success</ErrDes>

<Data>

<AvailablePickupDay>

<Date>2024-10-23</Date>
<MinReadyDate>2024-10-23T08:00:00+02:00</MinReadyDate>
<MaxPickupDate>2024-10-23T16:00:00+02:00</MaxPickupDate>
<Minimumlnterval>120</MinimumInterval>
</AvailablePickupDay>

<AvailablePickupDay>

<Date>2024-10-24</Date>
<MinReadyDate>2024-10-24T08:00:00+02:00</MinReadyDate>
<MaxPickupDate>2024-10-24T16:00:00+02:00</MaxPickupDate>
<Minimumlnterval>120</MinimumInterval>
</AvailablePickupDay>

<AvailablePickupDay>

<Date>2024-10-25</Date>
<MinReadyDate>2024-10-25T08:00:00+02:00</MinReadyDate>
<MaxPickupDate>2024-10-25T16:00:00+02:00</MaxPickupDate>
<Minimumlnterval>120</MinimumInterval>
</AvailablePickupDay>

</Data>

</GetAvailablePickupsResult>

440 GIVEMESHIPPINGCODESTATUSFULLHISTORY

Metoda pozwalajgca pobrac¢ petng historie paczki za pomoca kodu nadania.
Czas zwracany w tagu <Data> jest w strefie UTC+1 (lokalny czas polski). Prosimy zignorowa¢ znak “Z”
na koncu formatu czasu.
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4.40.1 Wywolanie

<ShippingCode>

Kod nadania przesytki (REQUIRED) 7 char

Identyfikator Klienta nadany

<partneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto Klienta nadane przez
<partnerKey> ORLEN Paczka (REQUIRED) 10 char

Zwracane wartosci:

4.40.2 Odpowiedz

<PackCode>

Numer kodu paczki zaawizowanej

<Trans>

Status paczki

<Trans_Des>

Opis statusu

<Data>

Data od kiedy paczka jest w statusie

<Destination>

Kod POPeR

<Cl_From>

Nr Centrum Logistycznego, na obszarze, ktérego przesytka zostata
nadana

<Cl_From_Des>

CL, na obszarze ktérego przesytka zostata nadana

<CI>

CL, na obszar ktdrego przesytka zostata zaawizowana

<Cl_Des>

Nr CL, na obszar ktérego przesytka zostata zaawizowana

<Attribute>

Atrybut przesytki (MOBILNY — punkt mobilny, ALTERNATYWNY — punkt
alternatywny, ZMIENIONY — punkt zmieniony, POWROT — powrot
przesytki do punktu nadania, 2_POWROT — powrét przesytki do
magazynu nadania, ZWROT — paczka zwrotna do magazynu nadawcy)

<StreetName>

Ulica, na ktdérej miesci sie Punkt Odbioru Paczek

<City>

Miasto, gdzie miesci sie POP

<OpeningHours>

Informacja o godzinach otwarcia POP

<Location>

Opis lokalizacji Punktu Odbioru Paczek

Przyktad:

<PackCode>2100123123123</PackCode>

<Trans>200</Trans>

<Trans_Des>Zaawizowana do PWR</Trans_Des>
<Data>2024-01-08T09:03:00.5701769Z</Data>
<Destination>WR-561043-11-11</Destination>

<Cl_From>0000</CI|_From>

<Cl_From_Des />
<CI>9305</Cl>
<Cl_Des />
<Attribute />

<StreetName>KOLBERGA 1</StreetName>

<City>Jelenia Géra</City>

<OpeningHours>Pn-Pt:07:00-17:00, S0:08:00-14:00, Nd: nieczynne</OpeningHours>
<Location>Automat paczkowy obok sklepu</Location>

</PackStatus>

441 PUTCUSTOMERSHIPPINGCODECANCELED

Metoda pozwalajgca anulowac¢ kod nadania.
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4.41.1 Wywolanie

Parametry wywotania:

<ShippingCode> Kod nadania przesytki (REQUIRED) 7 char
Identyfikator Klienta nadany

<partneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto Klienta nadane przez

<partnerKey> ORLEN Paczka (REQUIRED) 10 char

4.41.2 Odpowiedz

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
Przyktad:
<Err>000</Err>

<ErrDes>Saved</ErrDes>

4.42 GENERATECUSTOMERRETURN

Metoda pozwalajgca wygenerowac etykiete zwrotng powigzang z paczka pierwotna.
W celu uruchomienia ustugi zwrotu konsumenckiego nalezy skontaktowac sie z opiekunem
handlowym ORLEN Paczka.

Aby wygenerowac przesytke zwrotng, w danych awizacyjnych przesytki pierwotnej (zadeklarowanych
w zadaniu dla metod GenerateBusinessPack, GenerateBusinessPackTwo,
GeneratelabelBusinessPack, GeneratelLabelBusinessPackList, GenerateLabelBusinessPackListTwo,
GeneratelabelBusinessPackTwo) nalezy przekaza¢ parametr
<ReturnQuantity>1</ReturnQuantity> oraz nie wypetnia¢ ponizszych pél:

- <ReturnDestinationCode>
- <ReturnEMail>

- <ReturnFirstName>

- <ReturnLastName>

- <ReturnCompanyName>
- <ReturnStreetName>

- <ReturnBuildingNumber>
- <ReturnFlatNumber>

- <ReturnCity>

- <ReturnPostCode>

- <ReturnPhoneNumber>

Wadwczas:
- Dane odbiorcy zostang zastgpione danymi nadawcy.
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Zwrot konsumencki zwigzany z przesytkg pierwotng dziedziczy jej uprawnienia. Oznacza to, ze jesli
przesytka pierwotna posiadata ubezpieczenie, to przesytka zwrotna rowniez bedzie nim objeta.

W odpowiedzi na zgdanie zostanie zwrdcony nowy numer przesytki zwrotnej. Dla numeru przesytki
zwrotnej nalezy wygenerowac etykiete za pomocg metod zwracajgcych duplikaty etykiet (rozdziaty
4.30 - 4.33).

4421 Wywotanie

Parametry wywotania:

Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<PackCode> Numer ean-13 przesytki (REQUIRED) 13 char
(REQUIRED)
9 char — numer bez prefixu +48
<SenderPhoneNumber> Numer telefonu nadawcy 12 char — numer z prefixem +48

Przyktadowe wywotanie:

<PartnerID>1234567890</Partner|D>
<PartnerKey>abcdefghijk</PartnerKey>
<PackCode>2100123123123</PackCode>
<SenderPhoneNumber>123123123</SenderPhoneNumber>

4.42.2 Odpowiedz

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
<packCode_base> Numer przesytki pierwotnej
<packCode_return> Numer przesytki zwrotne;j
<OBSZAR> Obszar
<MIKROREJON> Mikrorejon
<SORTOWNIA> Sortownia
<KURIER_ZWROTY> Kurier zwroty

Przyktad:

<Err>000</Err>

<ErrDes>saved</ErrDes>
<packCode_base>2100123123123</packCode_base>
<packCode_return>2100321321321</packCode_return>
<OBSZAR />
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<MIKROREJON>WSF9</MIKROREJON>
<SORTOWNIA />
<KURIER_ZWROTY>WSF9</KURIER_ZWROTY>

4.43 GENERATECUSTOMERRETURNSHIPPINGCODE

Metoda pozwalajgca wygenerowac kod nadania zwrotny powigzany z paczka pierwotna.
W celu uruchomienia ustugi zwrotu konsumenckiego nalezy skontaktowac sie z opiekunem
handlowym ORLEN Paczka.

Aby wygenerowac przesytke zwrotng, w danych awizacyjnych przesytki pierwotnej (zadeklarowanych
w zadaniu dla metod GenerateBusinessPack, GenerateBusinessPackTwo,
GeneratelabelBusinessPack, GeneratelLabelBusinessPackList, GenerateLabelBusinessPackListTwo,
GeneratelabelBusinessPackTwo) nalezy przekaza¢ nastepujace parametry:
<ReturnQuantity>1</ReturnQuantity> oraz nie wypetnia¢ ponizszych pél:

- <ReturnDestinationCode>
- <ReturnEMail>

- <ReturnFirstName>

- <ReturnLastName>

- <ReturnCompanyName>
- <ReturnStreetName>

- <ReturnBuildingNumber>
- <ReturnFlatNumber>

- <ReturnCity>

- <ReturnPostCode>

- <ReturnPhoneNumber>

Wadwczas:
- Dane odbiorcy zostang zastgpione danymi nadawcy.

Zwrot konsumencki zwigzany z przesytkg pierwotng dziedziczy jej uprawnienia. Oznacza to, ze jesli
przesytka pierwotna posiadata ubezpieczenie, to przesytka zwrotna rowniez bedzie nim objeta.

W odpowiedzi na zgdanie zostanie zwrdcony kod nadania przesytki zwrotnej.

4.43.1 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<PackCode> Numer ean-13 przesyftki (REQUIRED) 13 char
(REQUIRED)
9 char — numer bez prefixu +48
<SenderPhoneNumber> Numer telefonu nadawcy 12 char — numer z prefixem +48

83 API_ORLENPaczka_v_1_26_002



Przyktadowe wywotanie:

<PartnerlD>1234567890</PartnerlD>
<PartnerKey>abcdefghijk</PartnerKey>
<PackCode>2100123123123</PackCode>
<SenderPhoneNumber>123123123</SenderPhoneNumber>

4.43.2 Odpowiedz

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
<packCode_base> Numer przesytki pierwotne;j
<shippingCode_return> Kod nadania przesytki zwrotnej
<OBSZAR> Obszar
<MIKROREJON> Mikrorejon
<SORTOWNIA> Sortownia
<KURIER_ZWROTY> Kurier zwroty
Przykiad:
<Err>000</Err>

<ErrDes>saved</ErrDes>
<packCode_base>2100123123123</packCode_base>
<shippingCode_return>1234567</shippingCode_return>
<OBSZAR />

<MIKROREJON>WSC3</MIKROREJON>

<SORTOWNIA />
<KURIER_ZWROTY>WSC3</KURIER_ZWROTY>

4.44 GENERATESTANDARDCUSTOMERRETURN

Metoda pozwalajgca wygenerowac etykiete zwrotng w ustudze zwrotu konsumenckiego.

W celu uruchomienia ustugi zwrotu konsumenckiego nalezy skontaktowac sie z opiekunem
handlowym ORLEN Paczka.

Zgodnie z ustaleniami biznesowymi z opiekunem handlowym przesytka wygenerowana tg metoda
kierowana jest na adres siedziby firmy lub na adres wskazany do zwrotow.
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Parametry wywotania:

4.441 Wywolanie

Identyfikator klienta nadany

<PartnerID> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char

<PrintLabel>

Wydruk etykiety

(T—True, F—false) 1 char

Format etykiety (pdf, epl, zpl,

<Format> png) (REQUIRED) 3 char
Wybor etykiety do wydruku (1-
petny adres, 2- adres
anonimowy, 3 - pozostajg tylko
<PrintType> nazwy odbiorcy i nadawcy) (REQUIRED) 1 char
<BoxSize> Wielkos$¢ paczki (REQUIRED) 1 char

<Insurance>

Ubezpieczenie paczki

(T/F) 1 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> Firma nadawcy 70 char
<SenderStreetName> Ulica z adresu nadawcy (REQUIRED) 30 char

<SenderBuildingNumber>

Numer budynku z adresu
nadawcy

(REQUIRED) 10 char

<SenderFlatNumber>

Numer mieszkania z adresu
nadawcy

10 char

<SenderCity>

Miasto z adresu nadawcy

(REQUIRED) 30 char

<SenderPostCode>

Kod pocztowy z adresu nadawcy

(REQUIRED) 6 char

<SenderMailAdress>

Adres mailowy nadawcy

(REQUIRED) 30 char

<SenderPhoneNumber>

Numer telefonu nadawcy

(REQUIRED)
9 char — numer bez prefixu +48
12 char — numer z prefixem +48

<SenderOrders>

Dane referencyjne

30 char

Zewnetrzny numer nadawcy
(dodatkowe informacje w

<ExternalSenderPackageNumber> rozdziale 3.5.1) 30 char
Zewnetrzny numer przesytki
(dodatkowe informacje w
<ExternalPackageNumber> rozdziale 3.5.1) 30 char
<PackValue> Wartosc¢ przesytki (w groszach) 6 char

Przyktad z minimalng wymagana lista pal:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>

<PrintLabel>T</PrintLabel>

<Format>PDF</Format>
<PrintType>1</PrintType>
<BoxSize>S</BoxSize>

<SenderFirstName>ImieNadawcy</SenderFirstName>

<SenderLastName>NazwiskoNadawcy</SenderLastName>

<SenderStreetName>Przyktadowa</SenderStreetName>
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<SenderBuildingNumber>15</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>00-000</SenderPostCode>
<SenderMailAdress>mail@mail.pl</SenderMailAdress>
<SenderPhoneNumber>111222333</SenderPhoneNumber>

4.44.2 Odpowiedz

Etykieta w formacie PDF zwracana jest w tagu <LabelData>.

Zwracane wartosci:

<PackCode_RUCH> Numer ean-13 przesytki
<DEST_ODDZIAL> Centrum logistyczne, ktdre zrealizuje dostawe
przesytki

<KURIER_ZWROTY> Kurier, ktory zrealizuje dostawe przesytki

<OP_ADRES> Adres, na ktéry bedzie zwracana przesytka

<OP_KODPOCZTOWY> Kod pocztowy, na ktéry bedzie zwracana przesytka

<OP_MIASTO> Miasto, na ktére bedzie zwracana przesytka

<OP_NAZWA> Nazwa, na ktore bedzie zwracana przesytka

<OP_KRAJ> Kraj, na ktory bedzie zwracana przesytka
Przyktad:

<PackCode_RUCH>2100000000230</PackCode_RUCH>
<DEST_ODDZIAL>0130</DEST_ODDZIAL>
<KURIER_ZWROTY>03</KURIER_ZWROTY>
<OP_ADRES>ULICA 6/6</OP_ADRES>
<OP_KODPOCZTOWY>12-345</OP_KODPOCZTOWY>
<OP_MIASTO>MIASTO</OP_MIASTO>
<OP_NAZWA>NAZWA</OP_NAZWA>
<OP_KRAJ>PL</OP_KRAJ>

4.45 GENERATESTANDARDCUSTOMERRETURNSHIPPINGCODE

Metoda pozwalajgca wygenerowac kod nadania dla przesytki zwrotnej w ustudze zwrotu
konsumenckiego.

W celu uruchomienia ustugi zwrotu konsumenckiego nalezy skontaktowac sie z opiekunem
handlowym ORLEN Paczka.

Zgodnie z ustaleniami biznesowymi z opiekunem handlowym przesytka wygenerowana tg metoda
kierowana jest na adres siedziby firmy lub na adres wskazany do zwrotow.
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Parametry wywotania:

4.451 Wywolanie

Identyfikator klienta nadany

<PartnerID> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char

<PrintType>

Wybor etykiety do wydruku (1-
petny adres, 2- adres
anonimowy , 3 - pozostajq tylko
nazwy odbiorcy i nadawcy)

(REQUIRED) 1 char

<BoxSize>

Wielko$¢ paczki

(REQUIRED) 1 char

<Insurance>

Ubezpieczenie paczki

(T/F) 1 char

<SenderFirstName>

Imie nadawcy

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy (REQUIRED) 30 char
<SenderCompanyName> Firma nadawcy 70 char
<SenderStreetName> Ulica z adresu nadawcy (REQUIRED) 30 char

<SenderBuildingNumber>

Numer budynku z adresu
nadawcy

(REQUIRED) 10 char

<SenderFlatNumber>

Numer mieszkania z adresu
nadawcy

10 char

<SenderCity>

Miasto z adresu nadawcy

(REQUIRED) 30 char

<SenderPostCode>

Kod pocztowy z adresu nadawcy

(REQUIRED) 6 char

<SenderMailAdress>

Adres mailowy nadawcy

(REQUIRED) 30 char

<SenderPhoneNumber>

Numer telefonu nadawcy

(REQUIRED)
9 char — numer bez prefixu +48
12 char — numer z prefixem +48

<SenderOrders>

Dane referencyjne

30 char

Zewnetrzny numer nadawcy
(dodatkowe informacje w

<ExternalSenderPackageNumber> rozdziale 3.5.1) 30 char
Zewnetrzny numer przesytki
(dodatkowe informacje w
<ExternalPackageNumber> rozdziale 3.5.1) 30 char
<PackValue> Wartosc¢ przesytki (w groszach) 6 char

Przyktad z minimalng wymagana lista pal:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghijk</PartnerKey>

<PrintType>1</PrintType>
<BoxSize>S</BoxSize>

<SenderFirstName>ImieNadawcy</SenderFirstName>

<SenderLastName>NazwiskoNadawcy</SenderLastName>

<SenderStreetName>Przyktadowa</SenderStreetName>
<SenderBuildingNumber>15</SenderBuildingNumber>
<SenderCity>Warszawa</SenderCity>
<SenderPostCode>00-000</SenderPostCode>
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<SenderMailAdress>mail@mail.pl</SenderMailAdress>
<SenderPhoneNumber>111222333</SenderPhoneNumber>

4.45.2 Odpowiedz

Kod nadania w formacie teskstowym zwracana jest w tagu <ShippingCode>.

Zwracane wartosci:

<ShippingCode> Kod nadania
<DEST_ODDZIAL> Centrum logistyczne, ktdre zrealizuje dostawe
przesyiki

<KURIER_ZWROTY> Kurier, ktory zrealizuje dostawe przesytki

<OP_ADRES> Adres, na ktéry bedzie zwracana przesytka

<OP_KODPOCZTOWY> Kod pocztowy, na ktéry bedzie zwracana przesytka

<OP_MIASTO> Miasto, na ktére bedzie zwracana przesytka

<OP_NAZWA> Nazwa, na ktore bedzie zwracana przesytka

<OP_KRAJ> Kraj, na ktory bedzie zwracana przesytka
Przyktad:

<ShippingCode>1234567</ShippingCode>
<DEST_ODDZIAL>0130</DEST_ODDZIAL>
<KURIER_ZWROTY>03</KURIER_ZWROTY>
<OP_ADRES>ULICA 6/6</OP_ADRES>
<OP_KODPOCZTOWY>12-345</0OP_KODPOCZTOWY>
<OP_MIASTO>MIASTO</OP_MIASTO>
<OP_NAZWA>NAZWA</OP_NAZWA>
<OP_KRAJ>PL</OP_KRAJ>

4.46 ORLENPAczKAWEEKENDOPENPUDOPOINTS

Metoda zwraca dane punktow odbioru otwartych w sobote i/lub niedziele w ustudze ORLEN Paczka.
Metoda nie zwraca punktéw odbioru APM (automatdéw paczkowych), poniewaz sg one otwarte 24/7.

Jezeli godziny otwarcia zwrdcone w tagach <OpenHoursSaStart>, <OpenHoursSaEnd> rowne sg
00:00:00, oznacza to, ze punkt jest nieczynny w sobote. Wéwczas zwrdcona zostaje informacja w
tagu ‘IsSaturdayPickupAvailable’ = false.

Jezeli godziny otwarcia zwrdcone w tagach <OpenHoursSuStart>, <OpenHoursSUEnd> rdwne sg

88 API_ORLENPaczka_v_1_26_002




00:00:00, oznacza to, ze punkt jest nieczynny w niedziele. Wowczas zwrdcona zostaje informacja w

tagu ‘IsSundayPickupAvailable’ = false.

Punkt odbioru moze by¢ dostepny w sobote lub w niedziele lub w sobote i niedziele.

Parametry wywotania:

4.46.1 Wywolanie

Identyfikator klienta nadany

<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char

Zwracane wartosci:

4.46.2 Odpowiedz

<Err> Numer btedu
<ErrDes> Opis btedu
<Data> Lista punktow w ramach Ustugi ORLEN Paczka

Struktura <Data>

<WeekendOpenPUDOPointsDto>

| Dane punktu w ramach ustugi ORLEN Paczka

Struktura <WeekendOpenPUDOPointsDto>

<PSD> Kod POPeR 6 char
. Rodzaj punktu (Partnerski — PPP, PPK, stacja
<PointType> ORLEN — PKN) 3 char
<Address> Ulica, Numer budynku, numer lokalu 50 char
<PostCode> Kod pocztowy z adresu odbiorcy 6 char
<City> Miasto z adresu odbiorcy 30 char
<Longitude> Dtugos¢ geograficzna punktu odbioru 16 char
<Latitude> Szerokos¢ geograficzna punktu odbioru 16 char
<Province> Wojewddztwo 25 char
<PhysicalName> Nazwa wtasciwa punktu 70 char
<PhysicallLocation> Opis lokalizacji punktu 255 char
Informacja o godzinach otwarcia danego punktu | 8 char
<OpenH SaStart
penhourssastart> danego dnia tygodnia — sobota HH:mm:SS
Informacja o godzinach zamkniecia danego 8 char
<OpenHoursSaknd> punktu danego dnia tygodnia — sobota HH:mm:SS
Informacja o godzinach otwarcia danego punktu | 8 char
H . . L.
<OpenHoursSustart> danego dnia tygodnia — niedziela HH:mm:SS
Informacja o godzinach zamkniecia danego 8 char
<OpenH SuEnd> . . S
penriourssutn punktu danego dnia tygodnia — niedziela HH:mm:SS
. . . . 5 char
<IsSaturdayPickupAvailable> Czy s mozliwe odbiory w Sobote true/false
<IsSundayPickupAvailable> Czy sg mozliwe odbiory w Niedziel > char
y P ysa Y & true/false
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30 char
YYYY-MM-
DDTHH:mm:ss.ms

Czas ostatniej aktualizacji danych punktu

<PointLastModifiedTimestamp> .
odbioru

Przyktadowa odpowiedz:

<WeekendOpenPUDOPointsDto>
<PSD>925587</PSD>
<PointType>PPP</PointType>
<Address>Sienkiewicza 320</Address>
<PostCode>42-583</PostCode>
<City>Bobrowniki</City>
<Longitude>18.9796190000000</Longitude>
<Latitude>50.3800180000000</Latitude>
<Province>$lgskie</Province>
<PhysicalName>Delikatesy Kubik</PhysicalName>
<PhysicalLocation>obok przystanku Bobrownik i 1 Maja 1</PhysicalLocation>
<OpenHoursSaStart>06:00:00</OpenHoursSaStart>
<OpenHoursSaEnd>22:00:00</OpenHoursSaEnd>
<OpenHoursSuStart>06:00:00</OpenHoursSuStart>
<OpenHoursSuEnd>22:00:00</OpenHoursSuEnd>
<IsSaturdayPickupAvailable>true</IsSaturdayPickupAvailable>
<IsSundayPickupAvailable>true</IsSundayPickupAvailable>
<PointLastModifiedTimestamp>2026-03-09T02:10:18.0133333</PointLastModifiedTimestamp>
</WeekendOpenPUDOPointsDto>

4.47 GENERATEBROKERRETURN2HOME

Metoda stuzy do wygenerowania etykiety zwrotnej na wybrany adres. W odpowiedzi zwracany jest
wynik tekstowy operacji oraz etykieta w postaci danych Base64 w polu LabelData.

W celu uruchomienia ustugi zwrotu na adres nalezy skontaktowac sie z opiekunem handlowym
ORLEN Paczka.

4471 Wywolanie

Parametry wywotania:

Identyfikator klienta nadany
<PartneriD> przez ORLEN Paczka (REQUIRED) 10 char
Hasto klienta nadane przez
<PartnerKey> ORLEN Paczka (REQUIRED) 10 char
<BoxSize> Wielko$¢ paczki (REQUIRED) 1 char
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<OriginalPackageNumber>

Numer paczki pierwotne;j
powigzanej ze zwrotem

13 char

<PhoneNumber>

Numer telefonu odbiorcy

(REQUIRED) 9 lub 12 char

<EMail>

Adres e-mail odbiorcy

(REQUIRED) 30 char

<FirstName> Imie odbiorcy (REQUIRED) 30 char
<LastName> Nazwisko odbiorcy (REQUIRED) 30 char
<CompanyName> Nazwa firmy odbiorcy 70 char
<StreetName> Ulica z adresu odbiorcy 30 char

<BuildingNumber>

Numer budynku z adresu
odbiorcy

(REQUIRED) 10 char

<FlatNumber>

Numer lokalu z adresu odbiorcy

10 char

<City>

Miasto z adresu odbiorcy

(REQUIRED) 30 char

<PostCode>

Kod pocztowy z adresu odbiorcy

(REQUIRED) 6 char

<SenderEMail>

Adres e-mail nadawcy zwrotu

(REQUIRED) 30 char

<SenderFirstName>

Imie nadawcy zwrotu

(REQUIRED) 30 char

<SenderLastName>

Nazwisko nadawcy zwrotu

(REQUIRED) 30 char

<SenderCompanyName>

Nazwa firmy nadawcy zwrotu

70 char

<SenderStreetName>

Ulica z adresu nadawcy zwrotu

30 char

<SenderBuildingNumber>

Numer budynku z adresu
nadawcy zwrotu

(REQUIRED) 10 char

<SenderFlatNumber>

Numer lokalu z adresu nadawcy
zwrotu

10 char

<SenderCity> Miasto z adresu nadawcy (REQUIRED) 30 char
zwrotu

<SenderPostCode> Kod pocztowy z adresu nadawcy | (REQUIRED) 6 char
zwrotu

<SenderPhoneNumber> Numer telefonu nadawcy (REQUIRED) 9 lub 12 char
zwrotu

<SenderOrders> Dane referencyjne nadawcy 30 char

<ExternalSenderPackageNumber> | Zewnetrzny numer nadawcy 30 char

<ExternalPackageNumber> Zewnetrzny numer przesytki 30 char

<Format>

Format zwracanej etykiety (PDF,
PDF10, EPL, ZPL)

(REQUIRED) string

Przyktad z minimalng wymagana listg pol:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghij</PartnerkKey>
<BoxSize>S</BoxSize>
<PhoneNumber>111222333</PhoneNumber>
<EMail>firmazwroty@firma.pl</EMail>
<FirstName>imie odbiorcy</FirstName>
<LastName>nazwisko odbiorcy</LastName>
<StreetName>ulica odbiorcy</StreetName>
<BuildingNumber>15</BuildingNumber>

<City>miasto odbiorcy</City>
<PostCode>00-000</PostCode>
<SenderEMail>klient@mail.pl</SenderEMail>
<SenderFirstName>Imie nadawcy</SenderFirstName>
<SenderLastName>Nazwisko nadawcy</SenderLastName>
<SenderStreetName>ulica nadacy</SenderStreetName>
<SenderBuildingNumber>10</SenderBuildingNumber>
<SenderCity>miasto nadawcy</SenderCity>
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<SenderPostCode>90-001</SenderPostCode>
<SenderPhoneNumber>111222333</SenderPhoneNumber>
<Format>PDF</Format>

4.47.2 Odpowiedz

Etykieta zakodowana w Base64 zwracana jest w tagu <LabelData>.

Zwracane wartosci:

<Err> Numer btedu

<ErrDes> Opis btedu

<PackCode_RUCH> Kod EAN-13 przesytki

<DestinationCode> Kod POPeR

<PackPrice> Cena przesytki (w groszach)

<PackPaid> Optacenie przesytki true/false

<LabelData> Etykieta PDF (Base64)
Przyktad:

<diffgr:diffgram xmlns:msdata="urn:schemas-microsoft-com:xml-msdata" xmlns:diffgr="urn:schemas-
microsoft-com:xml-diffgram-vi">
<NewDataSet xmlns="">
<GenerateBrokerReturn2Home diffgr:id="GenerateBrokerReturn2Homel"
msdata:rowOrder="0">
<Err>000</Err>
<ErrDes>saved</ErrDes>
<PackCode_RUCH>3400940315351</PackCode_RUCH>
<DestinationCode>0130</DestinationCode>
<PackPrice>999</PackPrice>
<PackPaid>false</PackPaid>
</GenerateBrokerReturn2Home>
</NewDataSet>
</diffgr:diffgram>
</GenerateBrokerReturn2HomeResult>
<LabelData>zakodowana etykieta w BASE64</LabelData>

4.48 GENERATEBROKERSHIPPINGCODERETURN2HOME

Metoda stuzy do wygenerowania kodu nadania dla przesytki zwrotnej na wybrany adres. W
odpowiedzi zwracany jest kod nadania.

W celu uruchomienia ustugi zwrotu na adres nalezy skontaktowac sie z opiekunem handlowym
ORLEN Paczka.
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Parametry wywotania:

4.48.1 Wywolanie

<PartneriD>

Identyfikator klienta nadany przez
ORLEN Paczka

(REQUIRED) 10 char

<PartnerKey>

Hasto klienta nadane przez ORLEN
Paczka

(REQUIRED) 10 char

<BoxSize>

Wielkos$¢ paczki

(REQUIRED) 1 char

<OriginalPackageNumber>

Numer paczki pierwotnej powigzanej ze
zwrotem

13 char

<PhoneNumber>

Numer telefonu odbiorcy

(REQUIRED) 9 lub 12 char

<EMail>

Adres e-mail odbiorcy

(REQUIRED) 30 char

<FirstName>

Imi¢ odbiorcy

(REQUIRED) 30 char

<LastName> Nazwisko odbiorcy (REQUIRED) 30 char
<CompanyName> Nazwa firmy odbiorcy 70 char
<StreetName> Ulica z adresu odbiorcy 30 char

<BuildingNumber>

Numer budynku z adresu odbiorcy

(REQUIRED) 10 char

<FlatNumber>

Numer lokalu z adresu odbiorcy

10 char

<City>

Miasto z adresu odbiorcy

(REQUIRED) 30 char

<PostCode>

Kod pocztowy z adresu odbiorcy

(REQUIRED) 6 char

<SenderEMail>

Adres e-mail nadawcy zwrotu

(REQUIRED) 30 char

<SenderFirstName>

Imie¢ nadawcy zwrotu

(REQUIRED) 30 char

<SenderLastName> Nazwisko nadawcy zwrotu (REQUIRED) 30 char
<SenderCompanyName> Nazwa firmy nadawcy zwrotu 70 char
<SenderStreetName> Ulica z adresu nadawcy zwrotu 30 char

<SenderBuildingNumber>

Numer budynku z adresu nadawcy
zwrotu

(REQUIRED) 10 char

<SenderFlatNumber>

Numer lokalu z adresu nadawcy zwrotu

10 char

<SenderCity> Miasto z adresu nadawcy zwrotu (REQUIRED) 30 char

<SenderPostCode> Kod pocztowy z adresu nadawcy (REQUIRED) 6 char
zwrotu

<SenderPhoneNumber> Numer telefonu nadawcy zwrotu (REQUIRED) 9 lub 12 char

<SenderOrders> Dane referencyjne nadawcy 30 char

<ExternalSenderPackageNumber> Zewnetrzny numer nadawcy 30 char

<ExternalPackageNumber> Zewnetrzny numer przesyiki 30 char

Przyktad z minimalng wymagana listg pol:

<PartnerID>1234567890</PartnerID>
<PartnerKey>abcdefghij</PartnerkKey>

<BoxSize>S</BoxSize>

<PhoneNumber>111222333</PhoneNumber>
<EMail>firmazwroty@firma.pl</EMail>
<FirstName>imie odbiorcy</FirstName>
<LastName>nazwisko odbiorcy</LastName>
<StreetName>ulica odbiorcy</StreetName>
<BuildingNumber>15</BuildingNumber>
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<City>miasto odbiorcy</City>
<PostCode>00-000</PostCode>
<SenderEMail>klient@mail.pl</SenderEMail>
<SenderFirstName>imie nadawcy</SenderFirstName>
<SenderLastName>nazwisko nadawcy</SenderLastName>
<SenderStreetName>ulica nadawcy</SenderStreetName>
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<SenderBuildingNumber>10</SenderBuildingNumber>
<SenderCity>miasto nadawcy</SenderCity>
<SenderPostCode>90-001</SenderPostCode>

<SenderPhoneNumber>»111222333</SenderPhoneNumber>

4.48.2 Odpowiedz
Kod nadania / wynik operacji zwracany jest w tagu <ShippingCode>.

Zwracane wartosci:

<Err> Numer btedu
<ErrDes> Opis btedu
<ShippingCode> Kod nadania
<DestinationCode> Kod POPeR

<PackPrice>

Cena przesytki (w groszach)

<PackPaid>

Optacenie przesytki true/false

<ShippingCodeExpirationDate>

Data waznosci kodu nadania

Przyktad:

<GenerateBrokerShippingCodeReturn2Home diffgr:id="GenerateBrokerShippingCodeReturn2Homel"

msdata:rowOrder="0">
<Err>000</Err>
<ErrDes>saved</ErrDes>
<ShippingCode>1234567890</ShippingCode>
<DestinationCode>0130</DestinationCode>
<PackPrice>999</PackPrice>
<PackPaid>False</PackPaid>

<ShippingCodeExpirationDate>2026-03-23T00:00:00+01:00</ShippingCodeExpirationDate>

</GenerateBrokerShippingCodeReturn2Home>

5 KOMUNIKATY BLEDOW

100 |brak PartnerlD

101 | brak PartnerKey

103 | brak PhoneNumber

104 | brak DestinationCode

105 |brak FirstName i LastName lub CompanyName
106 |brak PackCode

107 |brak PrintAdress

108 | brak Email

111 | brak SenderEMail

112 | brak SenderPhoneNumber
113 | brak SenderCity
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114 |brak SenderStreetName

115 |brak SenderBuildingNumber

116 |brak SenderPostCode

117 |brak SenderFirstName i SenderLastName lub SenderCompanyName
120 |brak AmountCashOnDelivery

121 | brak TransferDescription

123 | brak ReturnCity

124 | brak ReturnStreetName

125 |brak ReturnBuildingNumber

126 |brak ReturnPostCode

127 | brak ReturnCompanyName

128 | brak ReturnAvailable

129 |brak ReturnQuantity

130 |niedozwolone znaki w AmountCashOnDelivery
131 | niedozwolone znaki w TransferDescription
132 | niepoprawny format

133 | niepoprawny PhoneNumber

134 | niepoprawny PackValue

135 | PackValue przekracza maksymalng wartosé ubezpieczenia
136 | niepoprawny TransferDescription

137 | niepoprawny ReturnQuantity

138 | niepoprawny PostCode

139 | missing PrintType

140 |nie moze by¢ zero w AmountCashOnDelivery
141 | nieprawidtowy gabaryt BoxSize

142 | nieprawidtowy SenderPhoneNumber

143 | nieprawidtowy format dla etykiety (PDF / EPL / ZPL / etc.)
144 | nieprawidtowy numer paczki

150 |przekroczona maksymalna liczba paczek

161 | brak City

162 |brak Nip

163 |brak PackCode i PhoneNumber

164 |brak NumberOfWaybills

191 | nieobstugiwany kod pocztowy

201 |juz byta anulowana

202 |juz nie moze by¢ anulowana

205 | nieznany PackCode

206 | nieznany DestinationCode

207 | nieznany ReturnDestinationCode

208 | klient juz istnieje

209 | niepoprawny PackCode

211 |lack of routing data for this label

212 | no permission to this label number
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213 | parcel with this number already sent via RUCH

214 | paczka nie nalezy do partnera

222 | pack not found in RUCH system

223 | pack does not belong to partner

240 | zbyt wiele zwrotéw paczki

243 | niepoprawny PackCode

250 |brak PSD

251 |nieznany PSD

252 | nieznany ReturnPSD

253 [ nieznany AlternativePSD

254 | nieznany AlternativeDestinationCode

300 |btad zapisu

308 |brak uprawnien

309 |brak uprawnien do utworzenia klienta

310 |no permissionto COD

311 |no permission to Insurance

312 | no permission to Return

314 |brak uprawnier do nadan WhiteLabel

318 | no service COD in DestinationCode

330 |btad generowania etykiety

336 | btad generowania etykiety

350 |[kod przeterminowany / przed datg aktywacji / nie istnieje / wykorzystany / nieaktywny
399 |nie znaleziono paczki

400 |[zbyt duzo paczek podczas préoby otrzymania numerdéw listéw
401 |niepoprawny PartnerID i/lub PartnerKey

801 | brak paczek przekazanych do protokotu nadawczego

802 |[zbyt duzo paczek przekazanych do protokotu nadawczego

901 | nieokreslony btad

999 | API nie jest gotowe, aby potwierdzi¢ uprawnienia uzytkownika. Sprébuj ponownie za chwile.
1038 | parametr PartnerName jest puste lub NULL

1039 | parametr Street jest puste lub NULL

1040 |parametr City jest puste lub NULL

1041 |parametr PostCode jest puste lub NULL

1043 | parametr Email jest puste lub NULL

1052 |wartosé PickupDate nie zostata ustawiona

1053 |wartosé ReadyDate nie zostata ustawiona

1054 |wartosé PickupDate zostata ustawiona w niedziele

1055 | MaxPickupDate HOUR cannot be smaller than ReadyDate HOUR
1067 |incorrect interval's hours between MaxPickupDate and ReadyDate for this day
1077 |MaxPickupDate is invalid. Max available value for selected date: YYYY-MM-DD HH:MM:SS
1084 | pickup not available for selected day
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6 KOMUNIKATY OSTRZEGAWCZE, SWIADCZACE O POZYTYWNYM WYGENEROWANIU AWIZA

Pojawienie sie komunikatow 006, 007 lub 008 swiadczy o nieaktualnej liscie punktéw ORLEN Paczka.

Pobranie aktualnej listy punktdw zniweluje pojawienie sie komunikatéw. Nie sg to jednak btedy

uniemozliwiajgce wygenerowanie etykiety. Mimo ich pojawienia sie, etykieta wygeneruje sie

prawidtowo za$ w pole DestinationCode zostanie podstawiona aktualna wartos¢ definiujgca dany

punkt.
000 Zapisano
006 Zapisano ale zmieniono DestinationCode
007 Zapisano ale zmieniono ReturnDestinationCode
008 Zapisano ale zmieniono DestinationCode i ReturnDestinationCode

7 STATUSY PACZEK

Trans | Trans_Des Attribute
100 |W sortowni regionalnej NULL / 2_POWROT / POWROT / ZWROT
110 |W Transporcie do SC z Ekspedycji NULL /2_POWROT / POWROT
193 | Przekierowanie do APM NULL
195 |Przekierowanie do punktu NULL
200 |Zaawizowana do PWR NULL / 2_POWROT / POWROT / ZWROT
201 | Anulowane awizo NULL / 2_POWROT / POWROT / ZWROT
210 | Nadana w Kiosku NULL /ZWROT
230 | W Transporcie do Ekspedycji z Kiosku NULL / ZWROT
240 | W Transporcie do Ekspedycji u kuriera NULL /2_POWROT / POWROT / ZWROT
241 | W Transporcie po magazynowaniu NULL / POWROT
300 | W Sortowni Centralnej NULL / 2_POWROT / POWROT / ZWROT
400 | W Sortowni Centralnej NULL /2_POWROT / POWROT / ZWROT
450 | W Transporcie do Ekspedycji z SC NULL /2_POWROT / POWROT
653 | W Ekspedycji NULL /2_POWROT / POWROT / ZWROT
660 | W Transporcie do Kiosku u kuriera NULL /2_POWROT / POWROT / ZWROT
665 | Przekazana do Kiosku NULL /2_POWROT / POWROT
677 | Do nieczynnego kiosku NULL /2_POWROT
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NULL / 2_POWROT / POWROT

679 | Niewydana Kierowcy

680 | W Transporcie do Kiosku NULL / 2_POWROT / POWROT / ZWROT
681 | Do magazynowania NULL / POWROT

690 | W Kiosku NULL / 2_POWROT / POWROT / ZWROT
691 |Magazynowanie w punkcie NULL / POWROT

695 | W Kiosku SMS wystany NULL /2_POWROT / POWROT

696 | Magazynowanie w punkcie — SMS wystany NULL / POWROT

700 | W Ekspedycji do SC NULL / 2_POWROT / POWROT

708 | Magazynowanie w punkcie - nieodebrana NULL / POWROT

709 |Powrdt - Nieodebrana w Terminie NULL / POWROT

729 |Powrdt - Niepoprawny Kiosk NULL /2_POWROT / POWROT

739 | Nie przekazana do Kiosku NULL /2_POWROT / POWROT

749 |Reklamacja NULL

790 |Zwrot do ekspedycji NULL /2_POWROT / POWROT

800 |Zwrot do Sortowni NULL

888 |Archiwizacja NULL / 2_POWROT / POWROT / ZWROT
900 |Zwrot do Nadawcy NULL / 2_POWROT / POWROT / ZWROT
999 |Zniszczona - zagubiona NULL / 2_POWROT / POWROT / ZWROT
1000 | Odebrana przez Klienta NULL/2_POWROT/ POWROT

1100 |Odebrana POWROT

1200 | Odebrana - Zwrot ZWROT

1220 |Zwrot do nadawcy 2_POWROT
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